
You will need the Product ID number from the Registration Card
when you install the software. You also will need this number
if you phone for technical support. Please copy this number

to the line below so you will have it for future reference!

Product ID Number: _______________________
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AudioStation® 2
This software and documentation are copyright © 1992-1996 by
Voyetra Technologies. All rights reserved. No part of this publication
may be reproduced in any form or for any purpose without prior
written authorization from Voyetra Technologies. Voyetra, the
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Here’s How to Contact Voyetra Technologies

By mail............................ Voyetra Technologies
5 Odell Plaza
Yonkers, NY 10701-1406 USA

Fax............................ 914-966-1102
Bulletin Board............................ 914-966-1216 N, 8, 1
CompuServe®............................ 72702.2037

America Online®............................ voyetra@aol.com
Sales and Information ......................... 800-233-9377

Sales............................ sales@voyetra.com
Information............................ info@voyetra.com

Technical Support............................ 914-966-0600
Technical Support............................ support@voyetra.com

Website............................ http://www.voyetra.com
To Register Software ......................... register@voyetra.com
Registering Your Software

You can register your software by mail, fax, phone, BBS, Internet or WWW.

October 1996 ü Part Number: 04720-M01 ü ISBN 1-888743-12-3
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Using This Manual
AudioStation 2 controls your multimedia PC just like a home stereo
system! Its intuitive, hardware-style interface unites your computer’s
MIDI, WAV, and CD functions so they’re easy to control — and fun to
use. You’ll find that AudioStation is a welcome alternative to the utilities
supplied with Microsoft Windows.

AudioStation 2 is a suite of six separate applications which work to-
gether seamlessly. These include the Audio Mixer — to control volume
settings; the three players — CD Player , MIDI Player  and WAV Player ,
and two sound/music editors — MIDI Orchestrator  for MIDI files and
AudioView for WAV (digital audio) files.

The early chapters in this User’s Guide help you install the software and
introduce you to some of the basic controls and techniques necessary
to run the applications. The later chapters focus on each application
individually.

If you encounter any problems during installation or while using the
software, run MediaCheck ,™ Voyetra’s multimedia diagnostic utility.
It’s included with AudioStation 2 and installs automatically.

The Appendices at the back of the book contain useful information on
MIDI, digital audio, troubleshooting and diagnostics. A list of Keyboard
Shortcut Keys, the General MIDI Patch Set, General MIDI Drum Note
Map and General MIDI Controller Types also can be found here.

To find information about a specific control, menu item or dialog box,
refer to the Table of Contents at the front of the book or the
comprehensive Index at the back.

Now let’s get started...
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Chapter 1

Getting Started...

Welcome!
And thank you for purchasing AudioStation® 2. This program is one
in a series of Voyetra Technologies’ CD-ROM titles designed to bring
professional-quality music recording and editing to multimedia
computer users.

Voyetra Technologies has been in the business of music hardware and
software for more than 20 years. We are the world’s leading provider of
interactive sound, audio, and music multimedia software. Our software
is included with many of the sound cards and PCs sold today, so there
is a good chance you already own some of our other products.

Whether you are a new acquaintance or a Voyetra veteran, you will
benefit from our long-standing upgrade policy and our excellent
technical support.

As a registered user, you are entitled to special discounts on our other
products — but we can’t offer you these benefits if we don’t know who
you are. So before you install AudioStation 2, take a minute to register
your software...and welcome to the Voyetra family!
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On the World Wide Web

When you’re “surfing the net,” be sure to visit Voyetra’s Website for the
latest information on products and upgrades — www.voyetra.com

You can register your software by mail, fax,
phone, BBS, Internet or World Wide Web —
whichever is easiest for you. See the front of this
manual for these addresses.

Benefits of Registering Your Software
There are many benefits to registering your software. In addition to our
limited warranty, you’ll also receive:

• Update Notifications — we’ll keep you informed of software
updates and new Voyetra products.

• VoyeTracks™ Newsletter — we’ll let you know about
developments at Voyetra Technologies, with information on
how others are using our software and tips to help you get the
most from our products.

• Upgrade Plan — we’ll offer you discounts on Voyetra’s full-
featured PC sound products.

• Technical Support — we’ll be happy to help you get your
software installed before you register; however, you must be a
registered user to receive full technical support.

Your Product ID Number appears on the
Registration Card. Be sure to write this number
in the front of this manual so you will have it
available should you need to phone for Technical
Support.
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What’s Included
AudioStation 2 has components for all of your audio needs:

Software

Audio Mixer
Lets you easily access the volume controls of your PC while
you are running other multimedia applications.

CD Player
Plays commercial audio CDs on your PC’s CD-ROM drive.  It
has the same features as a home CD player including looping
and shuffle play. You can also make playlists of your favorite
songs and save the lists for future listening sessions.

WAV Player
Plays and records WAV files. Playlists let you create lists of your
favorite WAV files and play them back in any order. Edit the
files with AudioView.

AudioView™
Edit and record WAV files. Includes a full range of sound
effects including echo, reverse, normalize, scale, and more.
Embed sound files into OLE documents using drag-and-drop
techniques. This component can be launched directly from
within the WAV Player.

MIDI Player
Plays and records standard MIDI files (.MID).  Playlists lets you
create lists of your favorite MIDI songs and play them back in
any order.

MIDI Orchestrator™
Lets you mix and edit MIDI files by changing instruments,
transposing keys, adjusting tempo, muting or soloing specific
tracks, and more. This component can be launched directly
from within the MIDI Player.
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MediaCheck™

In addition to all of these applications, AudioStation also comes
with MediaCheck,™ Voyetra’s powerful, multimedia diagnostic
utility.

Use MediaCheck to test and troubleshoot the multimedia
features of your computer. A series of displays takes you step-
by-step through the testing process. If your system’s multi-
media devices are not working properly, MediaCheck provides
troubleshooting tips.

If you have a MIDI keyboard which needs to be connected to
your PC, MediaCheck has an online video tutorial which shows
you, step-by-step, how these connections are made.

Online Video Tutorials

There are six online video tutorials to help you become familiar with
AudioStation 2’s applications:

AudioStation® Overview Tutorial
Provides an overview of AudioStation’s components.

AudioStation® Mixer Tutorial
Illustrates how to use the Audio Mixer component.

CD Player Tutorial
Shows how to play audio CDs and create playlists.

MIDI & WAV Player Tutorial
Describes how to audition and play MIDI and WAV (digital
audio) files.

MIDI Orchestrator™ Tutorial
Shows how to record and edit MIDI files in Orchestrator.

AudioView™ Tutorial
Shows how to record and edit WAV (digital audio) files.
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Sample Files

To help you get started creating music quickly, we’ve included dozens
of sample files from Voyetra’s MIDI Music Gallery™ and Digital Sound
Gallery.™ These can be accessed directly from the CD-ROM.

Drum Tracks (located in the demos\drumtrax directory)
A variety of styles including pop, rock, jazz, funk and others.

MIDI Files (located in the demos\midfiles directory)
A selection of classical, action, rock, pop, religious and other
styles.

Hardware Requirements
These are the minimum hardware requirements to run AudioStation 2:

• IBM PC or compatible running Windows 3.1 or 95

• 486DX2/66 or higher processor

• 8 megabytes of RAM (Random Access Memory)

• SVGA monitor and adapter capable of displaying 640x480,
at least 256 colors

• Hard disk drive with at least 6 Megabytes of free storage space

• Double-speed (or faster) CD-ROM drive

• Windows Sound System (WSS) compatible sound card

• Headphones or speakers connected to your sound card

• An external MIDI keyboard is required for
recording MIDI files.

• An external sound source — such as a
microphone — is required for recording
WAV (digital audio) files.
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Hardware Notes

All of the multimedia hardware and software on your system must be
working correctly before  you install the software. If your system isn’t
working properly, neither will AudioStation 2!

• Microsoft Windows (3.1x or 95) must be installed and working
on your computer.

• An external MIDI keyboard must be attached to your computer
to record MIDI files. (For information on connecting your MIDI
keyboard, refer to “Setting Up Your MIDI Keyboard” in the
following chapter.)

• A microphone and/or external sound source must be attached
to your computer to record digital audio (WAV) files.

• Headphones and/or speakers must be connected to the jack
labeled “output” or “speakers” on the back of your sound card.

•  If you are using speakers, they need to have their own ampli-
fication since the output from the sound card may be too low
to power them. Speakers with built-in amps are powered either
by battery or AC.

Working with Windows
AudioStation 2 works with Microsoft Windows. To use AudioStation 2,
you need to have a basic knowledge of Windows techniques. This in-
cludes how to:

• Use the mouse to move the cursor, select items, click, double-
click, drag-and-drop.

• Work buttons, drop-down lists and other controls that appear
on Windows screens.

• Find, open, name, save and close files.

If any of these techniques are unfamiliar to you, refer to your Windows
manual or work through the tutorial included with Windows before
proceeding.
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Chapter 2

Up and Running

If you have a previous version of AudioStation installed
on your system, there’s no need to uninstall or delete it
before installing AudioStation 2.

Installing AudioStation 2
AudioStation 2 is extremely easy to install. It has an automatic installa-
tion process. The only important piece of information you will need to
provide is the Product ID Number. This number can be found on the
Registration Card for the software.

Since you will also require the Product ID Number if you need to phone
Voyetra Technologies for Technical Support, we recommend you write
this number in the space provided on the Title Page of this manual.
That way, you will always have the number handy.
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To Install the Software:

1. Make certain you have the Product ID number. (This number
can be found on the Registration Card.)

2. Place the CD in your computer’s CD-ROM drive.

• For Windows 3.1, choose Run from the Program
Manager’s File menu.

• For Windows 95, choose Run from the Taskbar’s Start
menu. (When you insert the AudioStation 2 disc for the
first time in Windows 95, you are automatically prompted
to run it.)

3. In the Run dialog box, type the letter of the drive followed by
\setup. If your CD-ROM drive is d:, type d:\setup and press
Enter.

4. Follow the on-screen instructions.

In Windows 3.1, you are prompted to install Video for
Windows. You need Video for Windows to run Audio-
Station’s online video tutorials and MediaCheck’s “Setup”
video.

README File
During installation, a README file with important information, may be
installed. If a README exists, we suggest you read it before you
proceed.

To View the README File:

1. Double-click the README icon.

2. In Windows 3.1, Windows Write will open and display the file.
In Windows 95, WordPad will open and display the file.

3. To print the README file, choose Print from the File menu of
either Windows Write or WordPad.
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Running the Software

Voyetra AudioStation 2
Program Group

Each module in AudioStation 2 has
its own icon.

• Clicking an individual icon calls
up an individual application.

• Clicking the AudioStation 2 icon
displays the entire AudioStation
rack — with the Power Bar,
Audio Mixer, and CD, WAV, and
MIDI Players displayed.

AudioStation’s applications are in-
stalled to your hard drive. However,
to run MediaCheck, the Online
Video Tutorials, or the Voyetra
catalog, the AudioStation 2 disc must
be in the CD-ROM drive.

Uninstalling AudioStation 2
Should you decide to remove AudioStation 2 from your hard drive, the
included Uninstall utility allows you to do so easily. But be careful!
Uninstall removes everything — even files you have created — from the
Voyetra\AS2 directory.

Uninstall will remove everything in your Audio-
Station 2 directory — even files you have created
which were not part of the original program. Be
certain to carefully read the on-screen instructions
before running Uninstall!

If you need to reinstall AudioStation 2, there is no need to uninstall it
first!
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Online Video Tutorials
AudioStation 2 comes with a series of six online video tutorials. These
tutorials help you learn about the software by watching videos right on
your computer’s monitor.

This is a good time to view the first video, the AudioStation Overview
Tutorial, which helps you become acquainted with all of the modules
in AudioStation.

AudioStation 2 Video Tutorial Menu

To View the Overview Tutorial Video:

1. Make certain the AudioStation 2 disc is in the CD-ROM drive.

2. Click Online Video Tutorials in the Voyetra program group.

3. When the Video Tutorial Menu displays, click ❶ to view the
AudioStation Overview Tutorial.

4. Sit back, relax, and enjoy the video!
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Chapter 3

Let’s Do Launch

Launching the Rack
AudioStation 2 contains the Audio Mixer and the three Players  — CD
Player, MIDI Player, and WAV Player —  all in one convenient “rack.”

When the AudioStation rack is displayed, you can close one or all of the
components from the Power Bar located at the top of the AudioStation
rack display. For more information on using the Power Bar, refer to the
“Power Bar” chapter.

There are several ways to launch AudioStation:

• Click Start. Point to Programs. Point to Voyetra AudioStation.
Click AudioStation 2.

• Double-click the AudioStation icon in the Voyetra\AS2
directory.

• Right-click the Voyetra System Tray Icon and click
AudioStation.
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Voyetra AudioStation 2
Program Group

Voyetra System
Tray Menu

AudioStation 2 “Rack”

In the AudioStation 2
program group, click
the AudioStation icon
to launch the Audio-

Right-click the
Voyetra System
Tray Launcher to
display a menu.

Then click AudioStation
to display the Audio-
Station rack.O R
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If Some of the Modules Appear to be “Missing”

You can use the Power Bar to customize AudioStation 2 by closing
various Players or rearranging the order in which the Players are
displayed. Refer to the “Power Bar” chapter for additional information.

AudioStation’s rack maintains the “look and feel” of how the software
appeared the last time you used it. Therefore, if you exit AudioStation
with one or more Players closed, these Players will not appear on the
rack the next time you open AudioStation. But don’t despair! The four
buttons along the top of the Power Bar correspond to the three Players
and the Audio Mixer. Clicking the appropriate button(s) will once again
display whichever components previously were closed down.

The Power Bar

You may not see all the components when you run
AudioStation. This is because the component is not
activated. When a Player or the Audio Mixer is
activated, its icon lights. To activate the Player or
Audio Mixer, click the appropriate button on the
Power Bar and the component once again displays
in the rack.

WAV
Player

MIDI
Player

CD
Player

Audio
Mixer
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Launching the Individual Players
Sometimes you will only want to open one or two of the components
— not the entire AudioStation rack. For example, you may only want to
use the CD Player to listen to an audio CD while you work at your PC.
There are several way to do this:

• Right-click the Voyetra System Tray Icon and click the Audio
Mixer or the Player’s name.

• Click Start. Point to Programs. Point to Voyetra AudioStation.
Click the Audio Mixer or the Player’s name.

• Double-click the Audio Mixer or the Player’s icon in the
VOYETRA\AS2 directory.

This will call up the specific Player or the Audio Mixer.

Clicking the CD Player icon calls up the CD Player
without the entire AudioStation rack.

Right-click to
display this menu
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Chapter 4

AudioStation Controls
Many of the modules in AudioStation 2 use similar controls. This
chapter covers the basic controls which you will encounter —
Transport Controls, Volume Controls (Sliders), Play Position Slider, and
additional buttons.

Transport Controls
The Transport controls are similar to the control buttons found on a
VCR or tape deck. They control functions such as Play, Rewind, Pause,
Fast Forward, and so on.

Transport controls on AudioStation’s three media players — the CD
Player, MIDI Player, and WAV Player— are similar in almost every
respect. The only differences are:

• The CD Player has an Eject button to eject the CD.

• The MIDI and WAV Players have a Record button to record
their respective file types.
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Transport Controls — CD Player

Transport Controls — MIDI and WAV Players

Operating the Transport Controls

Using the Transport Controls is as easy as pointing-and-clicking.

To Use the Transport Controls:

1. Place the mouse pointer on the desired button.

2. Click the left button on the mouse to “press” the button on the
screen.

Rewind

Stop

Play

Pause

Fast
Forward

Eject

Previous
Track

Next
Track

Rewind

Stop

Play

Pause

Fast
Forward

Recor

Previous
Track

Next
Track



AudioStation Controls 29

Here’s What the Transport Controls Do

This table describes the functions of the Transport Controls.

Rewind Rewinds the track (CD) or file (MIDI or
WAV) to the beginning, quickly, by
increments.

Stop Stops playback of the track (CD) or file
(MIDI or WAV).

Play Plays the track (CD) or file (MIDI or WAV)
from the current position.

Pause Pauses playback of the track (CD) or file
(MIDI or WAV) at the current cursor
position. To resume playing, press Pause
again.

Fast
Forward

Moves the audio track (CD) or file (MIDI or
WAV) forward, quickly.

Eject Opens/Closes the CD drive.
CD Player only!

Record Activates Record Standby. Recording
begins when the Play button is pressed.
MIDI and WAV Players only!

Previous
Track

Jumps back to the previous track (CD) or
file (MIDI or WAV) in the playlist.

Next
Track

Jumps forward to the next track (CD) or
file (MIDI or WAV) in the playlist.

Holding down the Shift Key and clicking the
Previous Track or Next Track button goes
to the first or last track in the Playlist.
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Volume Controls (Sliders)
In the various AudioStation modules, volume is controlled with sliders.
The volume can be adjusted either by using the mouse or with the
keyboard. The sound from a selected source can be turned off by
clicking the Mute button at the bottom of the slider.

To Operate the Sliders with the Mouse:

1. Place your mouse pointer on the desired slider.

2. Hold the left mouse button and drag the slider up or down.

To Operate the Sliders with the Keyboard:

1. Use the Tab key to move to each slider — from left to right.

2. To activate the slider, press the Spacebar.

3. Use the arrows keys on the keyboard to move the sliders up or
down.

To Operate the Mute Button:

• Click the Mute button at the bottom of the slider. The slider is
muted when the button is lit.

• To turn the sound back on, click the Mute button again.

Mute button

This symbol
indicates which

Player the
Slider controls
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Using the Volume Control Sliders

• If you want to move the left and right sliders simultaneously, place
the mouse pointer between the two sliders. The pointer changes to
an up/down arrow. By clicking-and-dragging, both sliders can be
moved in unison.

• If you click or click-and-hold the mouse pointer above or below the
slider, the slider moves toward the pointer.

Play Position Slider
The Play Position Slider — on the CD, WAV, and
MIDI Players — combines a digital clock display
with a horizontal slider. This shows at what point
in time the currently-playing file or track is
positioned. Dragging this slider to the left or right
moves to any point in the currently-playing
selection.

To Use the Play Position Slider:

1. Place the mouse cursor over the slider.

2. Hold the left mouse button and drag the slider left (to move to
an earlier position) or right (to move to a later position).

3. When the mouse button is released, the selection begins to
play at the selected time.

The Play Position Slider can be moved even
while the selection is playing!

Drag this
slider
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Additional Buttons
Three standard Windows buttons appear at the top of each Player.

From left to right these buttons are:

Help Clicking the ? displays online help for
AudioStation.

Minimize Clicking the — minimizes the application.

Close Clicking the X closes the application.

Help

Minimize

Close
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Chapter 5

Power Bar

The Power Bar launches AudioStation 2’s modules — the three media
Players and the Audio Mixer. These components are stacked from the
top down, in the order in which they are launched.

Power Bar Buttons

• To launch an individual module, click the appropriate button.

• To close all of the modules, click the Close button (X).

• • To minimize AudioStation, click the Minimize button (–).

• • To obtain online Help, click the question mark (?).

WAV
Player

MIDI
Player

CD
Player

Audio
Mixer

Minimize

Help Close
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Power Bar Right-Click Menu

Right-clicking on the Power Bar displays a menu with the following
commands:

Restore Restores AudioStation after Minimizing.

Move This function is not available in the Power Bar.

Size Is not used with AudioStation, so this function
remains unavailable.

Minimize Minimizes AudioStation.

Maximize Is not used with AudioStation, so this function
remains unavailable.

Close Exits AudioStation.

Save Settings
on Exit

Preserves the order in which the modules are
stacked on the rack — as well as which ones
are open — when this option is On (checked).

Show Voyetra
System Tray

Displays/Hides the Voyetra System Tray
Launcher.

About Power Bar Displays information about the version and
date, as well as the Product ID number.
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Voyetra System Tray Launcher

 
Right-click the

“V” to display a
menu

When you install AudioStation 2, you are
asked if you would like to replace the
Windows Volume icon with the Voyetra
System Tray Launcher.

If you choose this option, the Voyetra System Tray Launcher icon — the
“V” — will display in the Windows System Tray.

If you double-click the Voyetra System Tray
Launcher icon — the “V” —  the Audio Mixer will
launch.

Voyetra System Tray Launcher Menu

Right-clicking the Voyetra System Tray
Launcher icon displays a menu which
provides easy access to all of AudioStation’s
components.

This menu also launches the Audio Mixer,
from which you can control the overall
volume on your sound card.

To Display the Voyetra System Tray Launcher Menu:

• Right-click the “V” icon in the System Tray.
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The following items appear in the Voyetra System Tray Launcher menu:

AudioStation Launches AudioStation — with all its components.

Audio Mixer Launches the Audio Mixer.

MIDI Player Launches the MIDI Player.

WAV Player Launches the WAV Player.

CD Player Launches the CD Player.

Remove Launcher Removes the Voyetra System Tray Launcher.

About… Displays version and copyright information.

To Launch an AudioStation Component:

1. Right-click the Voyetra System Tray Launcher. A menu displays.

2. Click the name of the component you wish to launch.

To Remove the Voyetra System Tray Launcher:

1. Right-click the Voyetra System Tray Launcher. A menu displays.

2. Click Remove Launcher. The next time you start Windows, the
Windows Mixer icon will display in the System Tray.

Running the Voyetra System Tray Launcher

If you did not replace the Windows Volume Control with the Voyetra
System Tray Launcher and you wish to do so now, follow these steps:

1. Through Explorer in Windows 95, locate the AudioStation
directory. This is most likely C:\VOYETRA\AS2.

2. Double-click the file AS2TRAY.EXE. This runs the Voyetra
System Tray Launcher application. You will notice that the
Voyetra System Tray Launcher is now in the System Tray.
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Chapter 6

Audio Mixer

The Audio Mixer, shown here with slider volume controls and
Mute buttons for each of the Mixer’s functions. Because AudioStation’s

Mixer automatically detects the functions of your audio hardware
and configures the display accordingly, your Mixer may appear

slightly different than the one pictured above.

The Audio Mixer controls the volume levels on your sound card.
Because each sound card supports different mixer functions, not all
AudioStation Audio Mixers look the same. Depending on which sound
card you have, there may or may not be a Mute button beneath each of
the slider controls on the Mixer component.

Now’s a good time to view the AudioStation Mixer
Video Tutorial. Make certain the CD-ROM is in the
drive, click Online Video Tutorials, and then click .

For more information on how the mixer functions work on your sound
card, see the sound card manufacturer’s reference manual.
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Sound Sources
Your computer generates sound in a number of ways:

CD Audio Your computer can play a music (audio)
CD similar to the way you would play a
CD in your home stereo system.

MIDI Music
Synthesis

Your computer’s internal synthesizer
generates music for games and
multimedia applications.

Digital Audio
(WAV)

Your computer can play and record
digital audio files.

The Mixer has individual controls to adjust CD, MIDI, and WAV, as well
as microphone input and line-level output.

Use the Audio Mixer with all of your Windows multimedia and sound
applications.

C A U T I O N !

Do not use headphones the first time you use the
Audio Mixer! Some sound cards generate audio
signals strong enough to cause hearing problems
and/or discomfort.
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Record vs. Playback Mixer Modes

Most Audio Mixers have two modes — Record and Playback. If your
Mixer has this capability, the buttons to change between these modes
appear at bottom right of the Mixer’s faceplate.

• When Record is selected, the Mixer’s sliders control recording
levels.

• When Playback is selected, the Mixer’s sliders control playback
levels.

To Change Between Playback and Record Modes:

• Click the appropriate button. The button lights to indicate
which mode is active.

When the light on a Mute button is lit, the
component’s volume is muted and will not be
heard.
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Playback Controls
The controls for Playback differ slightly than the controls for Recording.

Your Mixer may look slightly different than the
one pictured above. If you are uncertain as to the
function of any of the icons, rest your mouse
pointer atop the icon and Tool Tips will identify
the sound source for you.

Adjusts the
overall volume

for playback.

Mute buttons — along the
bottom of the Mixer, silence the

selected source’s volume.

Adjusts the volume
level for the

microphone.

Adjusts the
volume level for

Adjusts the volume level of the sound
card’s internal synthesizer.

Adjusts the volume level of the
sound card’s digital audio

Changes from
Record to
Playback.

Adjusts the volume
level for an
auxiliary device.

Adjusts the line-level
volume output for the
sound card.

Advanced button — opens a
dialog box for Advanced Controls.
(Not available on all sound cards.)
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Record Controls
The controls for Recording differ slightly than the controls for Playback.

Your Mixer may look slightly different than the
one pictured above. If you are uncertain as to the
function of any of the icons, rest your mouse
pointer atop the icon and Tool Tips will identify
the sound source for you.

Changes from
Record to
Playback.

Adjusts the line-in
audio recording
volume.

Adjusts the CD’s audio level
for recording from a CD.

Adjusts the
recording level for
the microphone.

Adjusts the
volume level

for the sound
card’s

recording
level.

Adjusts the volume level for
recording the sound card’s
on-board synthesizer.

Mute buttons — along
the bottom of the Mixer,

silence the selected
source’s volume. This

function does not work
on the Main Volume

control.
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Advanced Controls
Some sound card drivers contain additional functions. In the Windows
Sound System, these functions are available through the Advanced
button, located at the bottom of the device’s volume controls.

Advanced button

To Use the Advanced Button:

1. Click the Advanced button for the device you wish to control.
A dialog box opens.

2. Turn the Advanced item On or Off by clicking its button. When
the option is On, the button lights.

If you are unsure of any control’s function, move
the mouse pointer over the control in question,
wait just a moment, and Tool Tip help will display
the control’s name.
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Customizing Your Mixer
AudioStation’s Audio Mixer uses an auto-detection feature to duplicate
the functions of the Windows Mixer which came with your sound card.
AudioStation 2’s powerful ability to auto-detect the drivers on your
sound card means that different sound card mixers will vary slightly in
appearance.

However, if you would like, you can change the icons on the Audio
Mixer to suit your personal tastes — and to help you better identify
which device is being accessed by each volume slider.

To Change an Icon under a Slider:

1. Move the mouse
pointer over the icon
you wish to change and
click the right mouse
button. A dialog box
containing several
icons displays.

2. Use the scroll bar or the arrows to find an icon that best
represents the volume slider control.

3. Click the icon you want, then click OK. The old icon is
replaced.

 Note that you are only changing the icon — not
the device the volume slider is controlling!
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Right-Click Menu
Right-clicking anywhere on the
Audio Mixer displays a menu
which contains information
about the Audio Mixer and gives
you control over its appearance.

The right-click menu contains the
following controls:

Restore Restores the Audio Mixer after minimizing.

Move Moves the Audio Mixer to any location on the
screen. (Only available when the Audio Mixer is
launched as a separate component.)

Size Is not used with the Audio Mixer.

Minimize Minimizes the Audio Mixer. (Only available when
the Audio Mixer is launched as a separate
component.)

Maximize Is not used with the Audio Mixer.

Close Exits the Audio Mixer.

About Audio Mixer… Displays information about the version number,
date, and Product ID number.

WSS Compatible
Mixer

Switches between the Windows Sound System
compatible mixer and the sound card’s mixer.

Configure Opens the Configure dialog box to change the
appearance of the Audio Mixer. (You can only
Configure your Mixer if it is set to WSS
Compatible.)
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Moving the Audio Mixer
If you don’t like where the Audio Mixer is situated on the screen, it’s
easy to move it to another location.

To Move the Audio Mixer around the Screen:

1. Place the mouse cursor on the Audio Mixer and wait until the
mouse pointer changes to a hand.

2. Click and hold the left mouse button; the fingers of the hand
icon curl slightly.

3. Move the mouse — the Mixer moves along with it.

4. When you find a convenient location for the Mixer, release the
mouse button. The Mixer is not positioned at that location.

Use the hand
icon to move the
Audio Mixer to a
new location on

the screen.



46 AudioStation 2

Windows Sound System Compatible Mixer
When you start the Audio Mixer, its controls are compatible with the
Windows Sound System (WSS) — its default setting. With these con-
trols, you can use all the features that your sound card is capable of.

• In some cases, you can switch between the WSS compatible
mixer and an older sound card mixer.

• If you have an older mixer made specifically for your sound
card by Voyetra, you can access it from a pop-up menu.

• Use the old mixer only if you have an old driver for your sound
card that does not work with the Windows Sound System.
Otherwise, you should always use the WSS Compatible Mixer.

To Switch between the
Two Mixers:

1. Right-click the Mixer.

2. On the pop-up menu
which appears, click WSS
Compatible Mixer to
deselect it (remove the
check mark).

3. Restart the Mixer as you
are prompted to do.

After you close and restart the mixer, you will notice changes to its
faceplate.

 If your card is not supported, the WSS compatible
mixer option will be unavailable.
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Configuring the Audio Mixer

Audio Mixer Pop-Up Menu

Through the Configure dialog
box, you can change the appear-
ance of the Audio Mixer. You can
reorganize the order in which the
controls appear and add or
remove controls — as long as
these controls are available on
your system.

You access the Configure dialog
box through the right-click pop-
up menu.

To Open the Configure Dialog Box:

1. Right-click on the Audio Mixer to display the pop-up menu.

2. Click Configure on the menu to open the Configure dialog box.

3. When the box opens, notice that the list in the Mixer box, on
the right, contains the list of controls currently on the Audio
Mixer.

 The button of the Mixer you are currently
working with — Play or Record — will be lit.
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Audio Mixer Configure Dialog Box

Since each system has its own hardware
specification, what you see in this manual
may vary from what you see on your screen.

To Add a Mixer Control:

1. In the Driver box on the left, click to highlight the name of the
control you want to add.

2. Click the Add button. The control is added to the list in the
Mixer box.

3. Click OK. You will now see the control added to the Audio
Mixer.

Click to select the
Playback  Mixer

controls.

Click to select the
Record Mixer

Click to Add the
highlighted control.

Click to
Remove the
highlighted
control.

The
highlighted

control
you want

to add.

The
highlighted
control you
want to
remove.
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• You can only add one instance of each control
to the Audio Mixer.

• Controls are always added to the end of the list.

To Remove a Mixer Control:

1. In the Mixer box on the right, click to highlight the name of
the control you want to remove.

2. Click the Remove button. This removes the control from the
Mixer box.

3. Click OK. You will notice that the control is no longer on the
Audio Mixer.

Removing controls from the Audio Mixer does not
remove them from your system — it only removes
them from the Audio Mixer. You can always add
the controls back to the Audio Mixer at a later
date.

Changing the Order of the Mixer Controls

The order of the list, from top to bottom, corresponds to the Mixer
controls from left to right.

It is easy to change the order in which the controls appear on your
Mixer. When adding controls, their names are only added to the end of
the list — you cannot add a control to the middle of the list. Therefore,
the topmost control listed in the Mixer box will be the first control on
the left of the Audio Mixer.

If, for example, you had three controls — MIDI, WAV and CD — and
you wanted them to appear in reverse order, you would need to take
the following steps.
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To Change the Order of the Mixer Controls:

1. Click each control to highlight it, then click the Remove
button. You should now have no controls in the Mixer box.

2. In the Drivers box, click CD, then click Add.

3. Click WAV, then Add.

4. Click MIDI, then Add.

5. The order should now appears as CD,WAV and MIDI — reverse
of the original order. This can be helpful when locating the
controllers on the Audio Mixer.
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Chapter 7

Playlists

What Is a Playlist?
A playlists provides an easy and convenient way to personalize the way
you hear music and sound on your computer. A playlist lets you select
files and play them back in any order you wish. Each of AudioStation’s
media players — MIDI, WAV, and CD — provides a dialog box from
which you can create your own playlists and save your favorite ones!

The playlist is a powerful feature. When playing back the songs on a
playlist, you can shuffle the lists of files and hear them in random order.
The CD Player even lets you name and save each CD and the tracks on
it!

The three media players work in much the same way, although there
are a few minor differences in the way playlists works in the CD Player
as compared to the MIDI or WAV Players. These differences are
explained throughout this chapter.

Although there are some differences in how the
Playlist feature works on the various Players, the
Playlist screen is accessed in the same way for
each of the Players.
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Playlists — MIDI and WAV Players
A playlist is created on the Playlist screen. This screen is slightly different
for the MIDI and WAV Players than for the CD Player.

Playlist Screen — MIDI and WAV Players

Playlist
button —
click to
display the
Playlist screen.

Audition — plays
(auditions) the file that is

currently highlighted in the
Files Name box.

Auto Audition — when enabled
(when the light is on), files which
are highlighted in the Files Name
box audition (play) automatically. Loads an existing

Playlist file.

Saves the
Playlist to
disk as a file.

Search
Selected
Drive —

finds all the
files, of the

selected
type, on the

selected
drive.

These
buttons
Add or
Delete

selections
from the
Playlist.

Files
Name

box

Type
list

box

The files
in your
Playlist
are
listed
here.

OK accepts
the playlist
and returns
to the
Player with
the playlist
loaded.

Intro
Play

button
Play Mode

Select
button
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Other Playlist Controls

Other buttons on the Playlist screen include:

Add Adds the highlighted file(s)/ track(s)
from the File Name box / CD tracks
box to the Playlist.

Add All Adds all the files/tracks currently listed
in the File Name box / CD tracks box to
the Playlist.

Delete Removes the highlighted file(s)/
track(s) from the Playlist.

Delete All Removes all files/ tracks from the
Playlist.

OK Closes the Playlist screen and returns to
the MIDI, WAV, or CD Player screen
with the updated playlist loaded.

Cancel Closes the Playlist screen and returns to
the MIDI, WAV, or CD Player screen
without updating the playlist.

Help Displays online Help for the MIDI,
WAV, or CD Player.
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Creating a Playlist — MIDI and WAV Players

It’s easy to create a playlist of the files you would like to hear.

To Create a Playlist:

1. Click the Playlist button at the lower right-hand corner of the
MIDI or WAV Player. This displays the Playlist screen.

2. Navigate to the drive and directory where the desired files are
located.

3. In the Type list box at the lower left of the Playlist dialog box,
choose the desired file extension. The Files Name box displays
all files with that extension.

• To hear a file before adding it to the Playlist, click to high-
light the file’s name in the Files Name box and then click
the Audition button  þ  at the top left of the screen.

• To automatically play a file when its name is highlighted
in the Files Name box, click the Auto Audition button.
When enabled, the button on the display is lit.

• To load all the files on a selected drive into the Files
Names box, click the Search Selected Drive button.

4. To add a file to the Playlist, double-click the file’s name in the
Files Name box. The file name will be added to the Playlist box
on the right.

5. Repeat these steps to complete the playlist.

6. Click OK to close the Playlist screen and return to the Player
with the newly-created Playlist loaded or click Cancel to return
to the Player without updating the Playlist.

To play a file without actually loading it, click
the Audition button.
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Playlists — CD Player

To create a CD Playlist, you must have an audio
CD in your computer’s CD-ROM drive!

Clicking the Playlist button on the CD Player displays a screen where
you can view the contents of the currently loaded CD, the number of
tracks on the disc, and the total length of the tracks in minutes:seconds.
This is the screen from which you create a customized playlist.

Initially, there are no titles for the tracks — you need to enter the names
of the tracks yourself. However, you only need to do this once. Then,
each time you load that CD, the CD Player automatically recognizes the
disc and displays the track names previously entered.

• When you first load a new CD, the CD Tracks list box on the
left side of the playlist window displays Untitled 1, Untitled 2,
and so on for each track on the disc. You can enter the titles of
the tracks (or any text you wish) and assign a name to the CD
itself using the Name Track and Name CD buttons located on
the CD Playlist screen.

• Above each list box (CD Tracks and Playlist) is a display
showing the Total Tracks and the Total Time for each list.

• The Add All and Delete All buttons add or delete all the tracks
from the playlist.

Although playlists are a convenient way to hear
your favorite selections, you can play CD tracks
without creating a playlist!
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Playlist Screen — CD Player

Name CD —
activates a dialog
box in which you

can enter a title for
the CD.

Name Track —
activates a dialog box

for naming each
track on the CD.

CD Tracks
Window — This

window displays the
tracks on the

audio CD.

Playlist Window —
this window displays
the playlist for the
audio CD.

These
buttons

Add
selections

to the
Playlist.

These
buttons
Delete

selections
from the
Playlist.

To save the
updated Playlist,

click OK.
To close

without saving,
click Cancel.
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Creating a Playlist — CD Player

Here’s how to create a playlist of your favorite tracks on an audio CD.

To Create a Playlist — CD Player

1. Click the Playlist button at the lower right-hand corner of the
CD Player screen. The CD Playlist screen displays.

2. To name the CD and the CD’s tracks, see the instructions
which follow.

3. Double-click the track’s name in the CD Tracks window (on
the left) to add it to the Playlist window (on the right).

4. Repeat the steps above to complete the playlist.

5. Click OK to return to the CD Player.

You don’t have to save the playlist. The CD
Player does this for you automatically!

Naming CD Tracks

The tracks on the audio CD appear as “Untitled” followed by a number
until you name them.

To Name the Tracks on a CD:

1. Click to highlight the desired track in the CD Tracks window.

2. Click the Name Track button.

3. In the dialog box which displays, enter a name for the track.

4. Press the Enter key, click the CD Next button or click the Up
or Down arrows.

5. Continue entering track names until you have completed the
list, then click OK.
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Naming a CD

The name of the CD appears as “Untitled” until you enter a name.

To Name an Audio CD:

1. In the CD Playlist screen, click the Name CD button.

2. In the dialog box which displays, enter a title for the disc.

3. Click OK.

Playing CD Tracks Without a Playlist
Although playlists are a convenient way to listen to the songs you
would like to hear, you can play audio CDs without creating playlists.

To Play an Audio CD without a Playlist:

1. Insert an audio CD in your CD drive.

2. Click the CD Player’s Playback Mode Select button to select a
mode — Single, Playlist, Shuffle, or Loop.

3. Use the Previous Track or Next Track buttons to select the
desired track.

4. Click the Play button.

If you need to increase or decrease the volume,
use the Audio Mixer and/or the volume control
sliders on the Player.
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Playlist Modes
There are four different playback modes. These can be accessed by
clicking the Playback Mode Select button.

Playback
Mode Select

button

Click this button to select one of the four
playback modes:

Single Mode In the MIDI and WAV Players, plays the
current selection in the playlist, then stops
when the file is complete.

Play All Mode In the CD Player, plays the entire CD once
through.

Playlist Mode Plays files or tracks in the order that they
appear in the playlist, starting with the
currently selected file, and stops after the last
file.

Shuffle Mode Plays the files or tracks in the playlist in
random order, continuing until you click the
Stop button or close the Player.

Loop Playlist Mode Plays all the files or tracks in the order in
which they appear in the playlist, starting
with the currently selected file, then repeats
the list from the beginning. This process
continues until you click the Stop button or
close the Player.
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 Listening to a Playlist — MIDI, WAV, CD
The steps for listening to a playlist are the same for all of the Players.

1. Select a playlist mode by clicking the Playback Mode Select
button on the front of the Player.

2. Click the Play button. The files or tracks in your playlist begin
to play.

3. To hear a different selection without waiting, use the Previous
Track selection and Next Track selection buttons to jump to
the desired selection.

To halt playback before the playlist is finished,
click the Stop button.

Inserting Items in a Playlist
Once you have created a playlist, you may want to add more tracks or
files to it.

To Insert a Single Item to a Playlist:

1. In the Playlist box on the right side of the Playlist screen, high-
light the line just below where you want to insert an item. If
you want to add an item to the bottom of the playlist, highlight
the blank line below the last item in the list.

2. In the Files Name box in the MIDI or WAV Player or the CD
Tracks box on the CD Player, double-click the desired file
name or track or highlight the file/track name and click the
Add button.
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To Insert Several Items in a Playlist:

1. Select an insertion point in the playlist by highlighting the line
just below where you want to insert an item. To add an item to
the end of the playlist, highlight the blank line below the last
item in the list.

2. In the Files Name box in the MIDI or WAV Player or the CD
Tracks box in the CD Player, select the items you wish to add.

• To select a group of consecutive items, click-and-drag the
mouse up or down over the desired items.

• To select a group of non-consecutive items, hold down
the CTRL key as you click on individual file names or
tracks.

3. Click the Add button.

To add all of the file names in the Files Name box
or all of the CD tracks in the CD Tracks box, click
the Add All button.

Deleting Item(s) from a Playlist
After you have created a playlist, you may decide that you no longer
want certain files or tracks to be part of the playlist.

To Delete Item(s) from a Playlist:

1. In the playlist box on the right, select the item(s) you wish to
remove.

2. Click the Delete button.

• To remove all of the items from the playlist, click the
Delete All button.
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Delete operations only remove files from a playlist.
They do not erase from the files or tracks from
your hard disk — or CD!

Saving a Playlist — MIDI and WAV Players

To Save a Playlist:

1. Click the Save button on the Playlist screen.

2. Navigate to the directory where you would like to keep your
playlists.

3. Type a file name in the Files box.

4. Click OK to save the playlist.

Loading a Playlist — MIDI and WAV

To Load a Playlist:

1. Click the Playlist button to display the Playlist screen.

2. Click the Load button.

3. Navigate to the drive and directory, then double-click the
desired file name.

Loading and saving playlists apply only to the
MIDI and WAV Players. You do not need to save
the playlist for the CD Player — it is saved auto-
matically. Also, once you have created a playlist for
an audio CD, whenever that CD is inserted in the
CD-ROM drive, the playlist previously created loads
automatically.
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Audition — MIDI and WAV Players
Audition lets you play a file without actually loading it.

The Audition button plays the highlighted file in the Files
Name box .

The Auto Audition button, when enabled (when the light
is on),  automatically plays the files which are
highlighted in the Files Name box.

• To audition a file, highlight the file name and click
the Audition button.

• To audition files automatically, activate the Auto
Audition button. The file begins playing the moment
you highlight it.

• To stop audition playback, de-activate the Auto
Audition button if necessary, then click on any file
name.

 Audition only works with the MIDI and WAV
Players!

Intro Play
Intro Play lets you to hear a file or CD track for a preset
amount of time.
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To Set an Amount of Time
for Intro Play:

1. Right-click on the Player to
display the system menu.

2. Click Intro Play.

3. Use the on-screen buttons
use the spin buttons to
select a length of time, in
seconds.

4. Click OK.

To Use Intro Play:

1. Create or load a playlist.

2. Click the Intro Play button. The files or CD tracks play for the
selected amount of time.

If using the CD Player, make certain an audio
CD is in the CD-ROM drive!
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Chapter 8

CD Player

Many CD players allow you to customize the way you listen to music. If
there is a selection you don’t want to hear, just press a button and skip
right over it. AudioStation’s CD player includes this feature —and more.

• You can easily create your own playlist — and play the tracks
you wish to hear in any order.

• The CD player lets you name the CD— and each track.

• When you place an audio CD in your computer, the CD player
automatically displays the name you previously entered.

Listen while you work! With the CD Player, you can catch up on that
work you need to do while your pre-programmed list of songs plays
quietly — or not so quietly — right on your computer!

Now’s a good time to view the CD Player Video
Tutorial. Make certain the CD-ROM is in the drive,
click Online Video Tutorials, and then click .
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CD Player Screen Areas

For information about the Transport Control
buttons along the button of the Player, refer
to the “AudioStation Controls” chapter.

Playing an Audio CD
Refer to the chapter on “Playlists” for instructions on how to play audio
CDs with AudioStation’s CD Player.

Displays the name of the
current CD.

Displays the name of
the current track.

Playlist Modes
— shows which
playlist mode is
currently in use.

Displays the current play
time in minutes:seconds. Displays the number of

the track playing in the
playlist.

Play Indicator —
displays when an audio

CD is being played.

Pause Indicator —
displays when the
CD Player is paused.

MultiCD Indicator — Displays which CD
is currently active. (This feature is not

available if you have only one CD drive.)

Intro Play Indicator —
displays if Intro Play is selected.

Playlist
button

Play Position
Slider
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Chapter 9

MIDI Player

The MIDI Player lets you record and play MIDI files on your sound
card’s built-in synthesizer and/or on external instruments. With the
MIDI Player, you can create custom playlists to hear your favorites time
and time again. A MIDI interface or connector is required to connect
external MIDI devices.

Should you wish to modify a MIDI file, the Launch MIDI Editor button
calls up MIDI Orchestrator, with the current MIDI file loaded and ready
for editing.

Now’s a good time to view the MIDI & WAV Player
Video Tutorial. Make certain the CD-ROM is in the
drive, click Online Video Tutorials, and then click .



68 AudioStation 2

MIDI Player Screen Areas

Recording MIDI Files
You can record a MIDI file using the MIDI Player. However, to save the
file, you need to use MIDI Orchestrator. Therefore, when recording a
MIDI file, it is preferable to click the Launch MIDI Editor button on the
MIDI Player to bring up MIDI Orchestrator where you have more
control over which track and instrument (patch) you are using in your
recording and you can save the file directly.

Current File —
displays the name

of the current
MIDI file.

MIDI Density
Meters — indicate
which channels are

active and, for those
that are, graphically

indicates the relative
number of notes

being played.

Displays which play
mode is currently
being used.

Displays the
current play time

of the file in
minutes:seconds.

Displays the track
number of the file
playing in the playlist.

Displays when a file is being played.

Displays when the
MIDI Player is paused

Displays if Intro
Play is selected.

Play
Position

Slider — lets
you move to
any position

in a song.

Launch
MIDI
Editor —
brings up
MIDI
Orches-
trator.

Play
Mode
Select
button

Playlist
button

Intro
Play

Select
button
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Recording & Saving Files with MIDI Player

To Record a MIDI File:

1. Click the Record button. The red LED blinks, indicating that the
module is in Record Standby mode.

2. Click the Play button to begin recording.

3. Play your MIDI device.

4. To pause temporarily during recording, click the Pause button.
Click the Pause button again to resume recording at the point
where you left off. (If you’d like, you can use the Spacebar
instead of the Pause button.)

5. Click the Stop button when you have finished recording.

6. Click the Play button to hear what you have just recorded.

7. You can follow the above steps to re-record if you wish. The
new material replaces the currently recorded material!

C A U T I O N ! !

To resume recording after pausing, use the Pause
button or the Spacebar. If you click the Record
button, you will erase the existing recording and
start a new one.

To Save the MIDI file:

1. Click the Launch MIDI Editor button to open MIDI
Orchestrator.

2. From the File menu, select Save.

3. Select a file format — .ORC, .RMI or .MID.

4. Type a new file name in the dialog box.

5. Click OK.
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Editing Files from the MIDI Player

To Edit a MIDI File:

1. Load a Playlist containing the desired file into MIDI Player — or
create a new playlist.

• You can also use the currently-loaded file. If you are using
the current file, skip to step 3.

2. Return to the MIDI Player and use the Next or Previous buttons
to access the desired file.

3. Click the Launch MIDI Editor button to open MIDI
Orchestrator.

4. Edit and save the file as desired.

For information on creating a Playlist, refer to the
“Playlist” chapter.

Launch MIDI Editor Button

The Launch MIDI Editor button on the MIDI Player
opens MIDI Orchestrator with the current file loaded.
MIDI Orchestrator lets you tailor MIDI files to your own
needs. Its channel-based mixing console makes it easy
to play, record, and optimize MIDI files. With MIDI
Orchestrator, you can easily select instrument sounds,
balance channel volumes, control tempo, transpose
tracks, add new tracks to existing MIDI files or create
multitrack MIDI compositions from scratch.
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Chapter 10

MIDI Orchestrator

MIDI Orchestrator™ lets you mix and modify MIDI files by changing
instruments, transposing keys, adjusting tempo, muting or soloing
specific tracks, and more. This component can be launched directly
from within the MIDI Player.

MIDI Orchestrator has 16 separate modules. Each module is a
collection of displays and controls which operate on a single MIDI
channel. In this way, you can Solo or Mute the channel, adjust its
volume and instrument sound, and control other parameters.
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MIDI Orchestrator Screen Areas

Now’s a good time to view the MIDI Orchestrator
Video Tutorial. Make certain the CD-ROM is in the
drive, click Online Video Tutorials, and then click .

Channel Info —
each of the numbered
buttons opens a dialog

box with a summary
of the parameters and

a set of controls for
its respective channel.

MIDI Density Meters —
Indicate which channels are
active and, for those that
are, graphically indicates the
relative number of notes
being played.

Solo — silences
all other channel
modules, making
it easier to
isolate one or
more channels.

Record
Channel
Select —
activates
the
selected
channel for
recording.

Mute —
silences
playback
of the
selected
channel.Pan —

changes the
instrument’s

pan (balance)
for the

selected
track.

Instrument — Selects
the instrument sound to
be used by a channel
module.

Volume — adjusts
the MIDI volume for
the selected channel.

Track Name — displays the first few
characters of the name of the first

track on each channel. As the mouse
pointer moves over the window, a

box displays the full track name.
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Transport Controls
The Transport Controls are located at the top of the screen, directly
beneath the menu bar. These controls are similar to the buttons on a
tape deck or VCR. For more information on using the Transport
Controls, refer to the “AudioStation Controls” chapter.

You can advance to either the beginning or the
end of a file by double-clicking the Rewind or
Fast Forward buttons.

Global Controls
The Global Controls affect the play location in the song and the tempo
for playback. These controls are located to the right of the Transport
Controls.

Current Song
Position  — displays

the location in the
song file where

playback will begin.
Use the mouse to

drag the slider to any
location in the song.

Tempo Offset — displays
and lets you modify a song’s

tempo overall by a fixed
amount, in beats per

minute.

Current Tempo — enables
you to set the current song’s

tempo in beats per minute.

Rewind

Stop

Play Pause

Fast
Forward

Recor
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MIDI Density Meters
MIDI Density Meters display how much MIDI
information is being sent through a channel. As
the number of MIDI signals increase, the higher
the meters will rise.

Status Area
The Status Area, at the bottom of the screen, displays information about
the Record/Playback status and length of the song being played.

Transport Status — displays
MIDI Orchestrator’s current
status. The options are Stopped,
Playing, Paused, Standby or
Recording.

Current Time — displays the elapsed
time from the beginning of the song to
the current position in Minutes:Seconds.

Total Time of Song — displays the total
length of the song in Minutes:Seconds, taking

the tempo setting into account.

Current Bar —
displays the
current song
position in
Bars:Beats.

Number of Bars in
Song — displays the

total length of the song
in Bars:Beats.
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Numericals
Numericals are small boxes that display parameters or
values. These provide a quick way to adjust numerical
values. Some numerical boxes have spin buttons — a small
pair of triangular up/down arrows.

• To increase the numerical value, click the top (up) arrow.

• To decrease the numerical value, click the bottom (down)
arrow.

To change the values in boxes with spin buttons, you can use the spin
buttons alone or in conjunction with the Shift and Ctrl keys.

To Increase a Value...

Action Where Effect

Click the mouse button on an up Spin
Button

to increase the value by
the smallest amount.

Press the + key when a numerical
box is selected

to increase the value by
the smallest amount.

Hold the Ctrl key and
press the + key

when a numerical
box is selected

to increase the value to
the maximum amount.

Hold the Shift key and
click the mouse button

on an up Spin
button

to increase the value by a
large amount.

Press the multiply * key when a numerical
box is selected

to increase the value by a
large amount.

Hold the Ctrl key and
click the mouse button

on an up Spin
button

to increase the value to
the maximum amount.
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To Decrease a Value...

Action Where Effect

Click the mouse button on a down Spin
Button

to decrease the value by
the smallest amount.

Press the – key when a numerical
box is selected

to decrease the value by
the smallest amount.

Hold the Ctrl key and
press the – key

when a numerical
box is selected

to decrease the value to
the minimum amount.

Hold the Shift key and
click the mouse button

on a down Spin
button

to decrease the value by a
large amount.

Press the divide / key when a numerical
box is selected

to decrease the value by a
large amount.

Hold the Ctrl key and
click the mouse button

on a down Spin
button

to decrease the value to
the minimum amount.
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File Menu

The commands in the File menu are:

New  Creates a new, empty file.

Open Presents a dialog box from which you can select the
file you wish to load.

Save Saves the currently-loaded file to disk. If the file
already has a name, it will be saved under that name.
Otherwise, the Save As... dialog box appears.

Save As... Presents a dialog box for naming and saving the
current file to disk.

Exit Closes MIDI Orchestrator.

1/2/3/4
(File List)

Lists the paths of the four most recently opened
files. To open a listed file, click once on its entry or
enter its number.
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Options Menu

The Options menu has three settings:

Metronome When enabled, the PC speaker clicks as a time
reference for recording.

To activate this feature:

• Click Metronome.

When the Metronome is activated, a check mark
appears next to its name.

Save Settings on Exit When enabled, the current Metronome setting is
saved when MIDI Orchestrator is closed.

To activate this feature:

• Click Save Settings on Exit.

When Save Settings on Exit is activated, a check
mark appears next to it.

MIDI Input Device Lets you select a MIDI input device for recording.
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Selecting a MIDI Input Device

To Select a MIDI Input
Device:

1. Select MIDI Input
Device… from the
Options Menu. A dialog
box appears.

2. Click the drop-down box to see a list of the MIDI input
devices available on your system.

3. Click the input device you wish to use.

4. Click OK to accept your choice.

MIDI Options Dialog Box

The Options button in the MIDI Input Device dialog box opens the
MIDI Options dialog box.

Keep MIDI Drivers Open
While Inactive

The Keep MIDI Drivers Open
While Inactive setting determines
how your MIDI configuration
changes when you switch from
MIDI Orchestrator to another
Windows program.

Opens MIDI
Options dialog box
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If Keep MIDI Drivers Open While Inactive is deselected — which is
its default setting — your MIDI drivers will be available to another
MIDI program when MIDI Orchestrator is inactive. However, this
closes the drivers for MIDI IN, MIDI OUT and MIDI THRU, and your
MIDI keyboard will not be available when using other applications.

If Keep MIDI Drivers Open While Inactive is selected, your MIDI
drivers will remain open even when MIDI Orchestrator is inactive.
This lets you play your MIDI keyboard when you switch to another
Windows application, but it may cause conflicts and system
instability if two MIDI applications are open simultaneously.

Send Reset Controllers on Stop

If your MIDI scores involve many controller change events, you will
probably want to select this option. If, for example, you have the
Volume and Pan controllers changing to simulate the motion of a
musician moving around a stage and you stop the song, auto-
rewind, then play it back, Volume and Pan remain at the values
they had when playback was stopped.

By enabling Send Reset Controllers on Stop, you can prevent this
subtle error. MIDI Orchestrator resets all the controllers to
eliminate unwanted controller settings from a previous song or
playback session.

Close MIDI IN While Using Wave

Some sound card drivers will report “Wave Device Already in Use”
if you try to record WAV files while simultaneously playing a MIDI
file. If you encounter this problem, select the Close MIDI IN While
Using Wave option when you are recording Digital Audio. This
closes the MIDI IN port, enabling you to simultaneously play MIDI
tracks and record digital audio.
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Clock Rate

Clock Rate sets the timing resolution with which MIDI Orchestrator
records. The higher the setting, the higher the resolution and the
greater the accuracy of your recording. The default Clock Rate setting is
Medium.

Set the Clock Rate to High if you are sending a large amount of MIDI
data and MIDI Orchestrator is “dropping” some of the data. The High
setting increases the timing resolution of MIDI Orchestrator and allows
for a greater degree of accuracy when recording MIDI. Be aware, how-
ever, that this setting can slow down your system.

You would only need to set the Clock Rate to Low if you have a slow
system and MIDI Orchestrator is having a problem recording your MIDI
data. In most cases, Medium is the most appropriate setting for the
Clock Rate.

Setting the Clock Rate

To Change the Clock Rate Setting:

1. From the Options menu,
select MIDI Input
Device.

2. In the MIDI Input device
dialog box, click the
Options button.

3. From the Clock Rate list, select Low or High.

4. Click OK.

In most cases, you will not have to change
the Clock Rate setting from its default of
Medium..
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Help Menu
In MIDI Orchestrator, Help is just
a mouse-click away.

There are several different types
of help to choose from. These
can  be enabled or disabled from
the Help menu.

A check mark to the left of the menu option indicates the feature is
turned on.

Contents Displays the entire Help file.

• Click Contents to open the Help file or press the
F1 key.

One Line Help Activates MIDI Orchestrator’s One Line Help system.
As you pause the mouse pointer on top of screen areas
and controls, single-line definitions are displayed in the
Title bar at the top of the application.

• Click One Line Help to activate this feature.

Tool Tip Help Displays the names of screen areas and controls as the
mouse pointer stops on top of them. The text is dis-
played in a small yellow window that pops up near the
mouse pointer.

• Click Tool Tip Help to activate this feature.

About… Displays MIDI Orchestrator’s “About...” box.
This contains the program’s revision number and
creation date, along with the Product ID Number.
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Loading and Playing a MIDI File
It’s easy to load and play files in MIDI Orchestrator!

File Open Dialog Box

To Open and Play a File:

1. Choose Open from the File menu and locate the drive and
directory where your MIDI files are located.

2. Double-click the file name of the desired song. As the song file
loads into MIDI Orchestrator, the sliders adjust to the correct
volume for each channel and the status indicators display the
length of the song.

3. Click the Play button to play the song. As the song plays, the
Status indicator displays “Playing,” the MIDI Density Meters
indicate the activity on each channel, and the Song Position
slider advances from left to right.

The MIDI Density Meters for some of the channels
may be grayed out. This is normal. It indicates
that there is no port assignment for those channels
in the Windows MIDI Mapper, so those channels
are unavailable.
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Channel Module Controls
MIDI Orchestrator has 16 channels — each with the following controls.

•  To Solo multiple channel modules, press
Ctrl+click on the desired Solo buttons.

• To adjust the Pan, click the control dial and
drag it to the setting you want.

Used for stereo
playback, the Pan
control sets the

channel’s left/right
positioning.

Turn the knob to the
left or right with your

mouse to set that
channel in the stereo

field.

Click the Solo button to
hear a single channel and
Mute all other channels,
thereby allowing you to hear
only the channel you soloed.
To Solo several channels,
hold down the CTRL key as
you click on the Solo button
for each of the desired

To silence a
channel, click its
Mute button.

You can mute as
many channels as

you wish.

Click and hold the left mouse
button to drag the Volume
slider up (to increase the
volume) or down (to decrease
the volume). If you click above
or below the slider, the slider
will move toward the mouse
pointer.

Click the Record Channel
Select button to enable
recording on the selected

channel. Click Instrument to open
the Instrument Selection
dialog box.

Channel Info — click this control to
open the Channel Info dialog box.

Move the mouse over the Track Name
area to display the full name of the track.
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Assigning Instrument Sounds with the Instrument
Selector

You can assign any of the 128 instruments to each channel and
these can be changed at any time — even as a song is playing.

To Select an Instrument:

1. Click the Instrument
Selector button for
the appropriate
channel. The Instru-
ment Selection dialog
box appears.

2. Double-click on an
instrument group, a
list of the instruments
in that group
appears.

3. Click on an instru-
ment to assign a new
sound.

4. Click OK.

If you’d prefer, you can use the up and down
arrow keys to move around the Instrument
Selection dialog box. Then press Enter to select the
instrument you have chosen.
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Setting or Changing a Song’s Tempo

To Change the Tempo for a Song:
1. Click the Tempo numerical.

2. Click the up or down spin button to set the initial
tempo for the song — or key in the desired value.

Some MIDI files contain a Tempo Map — a series of
additional messages to change the tempo at various
points throughout the song. Each tempo setting
remains in effect until a new one is encountered or
until the end of the song.

Adjusting All of the Tempos in a Song
The Tempo Offset control changes all the values in the
Tempo Map, including the initial one, by the amount you
select. This is useful when you want to change the overall
speed of a song that contains many tempo changes.

To Adjust All of the Tempos in a Song:

1. Click the Tempo Offset numerical.

2. Use the spin buttons to change the value up or down — or key
in the desired value.

For more information on using numericals, refer to
the  “Changing Numericals” section elsewhere in this
chapter.
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Channel Info Dialog Box

Each channel module has its own Channel Info dialog box. This box
provides a summary of all of the settings for that channel and enables
you to adjust them.

Tracks

The Tracks box lists the names
assigned to all of the tracks on
the channel and allows you to
select a track to name, re-name,
or transpose.

 When you use MIDI Orchestrator to record new
data in an existing MIDI file, the new material
creates a single track on the selected channel and
replaces all pre-existing data on all tracks assigned
to that channel.
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Selected Track

Selected Track does exactly as its
name indicates — it displays the
currently-selected track.

Transpose

Transpose lets you transpose the selected
track by octaves and/or semi-tones.

Instrument

Instrument lets you select an
instrument for that channel.

Naming or Renaming a Track

To Name or Rename a Track:

1. Click the Channel Info
button.

2. Type the desired name in the Selected Track box.

3. Click OK.

To make it easier to identify each channel, use this
procedure to edit the name of the first track. The first few
characters will appear in the channel module’s Track Name
area near the bottom of the main screen. Whenever the
mouse cursor rests in the Track Name area, the full track
name will be displayed.
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Transposing a Track

To Transpose a Track:

1. Click the Channel Info button of the
channel module containing the track you
want to transpose. That track name will be
displayed in the Selected Track box

2. Use the spin buttons in the Octave:Semitone numerical to
transpose the pitch up or down.

Recording

To record with MIDI Orchestrator, a MIDI inter-
face or connector and a MIDI keyboard are
required. Make sure the MIDI OUT of your key-
board is connected to the MIDI interface or sound
card’s MIDI IN.

To Prepare for Recording:

1. From the Options menu, enable the Metronome if you would
like the PC to produce a timing reference tone from the
speaker for each beat as you record.

2. Use the Tempo control to set the desired tempo.

3. Select the Channel module into which you wish to record by
clicking its Record Channel Select button. This red button
illuminates, indicating the Channel is enabled.

4. Use the Instrument Selector button to choose an instrument for
recording. For now, set the instrument to 1, which usually
creates the sound of a piano.
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5. Turn down the volume on your MIDI keyboard and play a few
notes. You should hear the selected instrument on the sound
card’s synthesizer. If you do, you’re ready to record.

During recording, all the incoming MIDI data,
regardless of its MIDI channel assignment, is
merged and placed into the one channel you have
selected.

Record Standby Mode

In Record Standby mode, the red light on the
Record button blinks to indicate that your system
is ready to record but hasn’t actually started yet.

From this point, you can click the Record Standby button again to
cancel Record Standby or you can click the Play button to begin
recording.

To Record a Melodic Track:

1. Click the Record Channel Select button on a Channel module
to activate that channel.

2. Click the Record button in the Transport Control area. The
blinking red light indicates that MIDI Orchestrator is in Record
Standby mode.

3. Click the Play button to start recording. The red light will stop
blinking and remain lit, indicating that MIDI Orchestrator is
recording. Also, the Status Indicator, at the bottom of the
screen, now reads, “Recording.” If you enabled the Metro-
nome, you should hear the PC speaker counting the tempo.

4. Play your part on the MIDI keyboard.

5. Click the Stop button to stop recording.

6. Click the Play button to hear what you have just recorded.

Play button
Record
Standby
button
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 If you wish to re-record the track, repeat the steps
above. Note that the new recording will replace
the entire previously recorded track.

You’ve Got the Beat

What’s a song without drums? Now‘s the time to add the beat!

Depending on how your MIDI system is set up, the drum channel may
be either 10 or 16. If you’re not certain which it is, use MediaCheck™
to help you determine which channel is your setup for drums. (For
information on using MediaCheck, refer to the “MediaCheck” chapter
in this User’s Guide.)

For a listing of which key triggers which drum
sound, refer to the Appendix, “General MIDI Drum
Note Map.” (Not all devices use the drums in this
listing. Check the documentation for your MIDI
device if necessary.)

To Record a Drum Beat:

1. Click the correct Record Channel Select for the drum channel
on your synthesizer. Each key on your MIDI keyboard will now
act as a different drum instrument.

2. Click the Record button in the Transport Control area. The
blinking red light indicates that MIDI Orchestrator is in Record
Standby mode.

3. Click the Play button to start recording. The red light will stop
blinking and remain lit, indicating that MIDI Orchestrator is
recording. Also, the Status Indicator now reads, “Recording.” If
you enabled the Metronome, you should hear the PC speaker
counting the tempo.

4. Play the drum part on the MIDI keyboard.

5. Click the Stop button to stop recording.

6. Click the Play button to hear what you have just recorded.
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If you don’t feel like creating a drum track, use one
of the sample tracks which came with AudioStation.
These are in the demos\drumtrax directory on the
AudioStation CD-ROM.

Overdubbing Additional Parts

For a richer, fuller sound, you’ll want to add additional parts.

You can use the Mute and/or Solo buttons to
silence other tracks when recording a new track.

To Add Additional Parts:

1. Choose another channel to record on.

2. Click on this channel’s Record Channel Select button.

3. Use this Channel module’s Instrument Selector button to
choose an instrument sound for the new part.

4. Click the Record button in the Transport Control area. The
blinking red light indicates that MIDI Orchestrator is in Record
Standby mode.

5. Click the Play button to start recording. The red light will stop
blinking and remain lit, indicating that MIDI Orchestrator is
recording. Also, the Status Indicator now reads, “Recording.” If
you enabled the Metronome, you should hear the PC speaker
counting the tempo.

6. Play your part on the MIDI keyboard.

7. Click the Stop button to stop recording.

8. Click the Play button to hear what you have just recorded.

 If you wish to re-record the track, repeat the steps
above. Remember, the new recording will replace
the entire previously recorded track.
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Saving

Choosing a File Format

MIDI Orchestrator lets you open and save song files in three formats —
.MID, .ORC and .RMI

.MID This format is compatible with most other PC MIDI
applications. When you save a file in this format,
settings for Tempo, Tempo Offset and Transpose are
combined and the resulting new values are saved.
Muted and unsoloed tracks are deleted.

.ORC If the file is just for your own use, or if you plan to
share the file with another application that supports
.ORC files such as Voyetra’s MIDI Player or Digital
Orchestrator Plus,™ save your file in this format. .ORC
also preserves all of the file’s settings independently,
just as you see them on screen.

.RMI Files in this format include a header with identifying
information which certain MIDI devices may require.
In other respects, RMI files are identical to standard
MIDI files.

When in doubt, use the .ORC format. You can
always re-open a file and save it in .MID format
later, if necessary.
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Saving a File

It’s always a good idea to save often — that way you won’t lose what
you have been working on.

The Save As... Dialog Box

To Save a File:

1. Choose Save from the File menu.

2. Select a file format, either .ORC, .RMI or .MID. (See “Choosing
a File Format” for more information about file types.)

3. Type a new file name in the dialog box.

4. Click OK.

Be sure to check all of your Mute and Solo settings
before you save a file in .MID format. Any tracks
that you have de-activated with the Solo or Mute
buttons will be deleted during the save operation.
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Chapter 11

WAV Player

In the past, playing WAV (digital audio) files was a clumsy proposition
at best. The sounds that enhance an application could not easily be ac-
cessed. You could listen to a single file, but to hear a string of them and
analyze each one — or change them to suit your tastes — was not easy.

WAV Player lets you load any number of WAV files and then play them
back in any order you see fit. Editing them is just a click away.

The WAV Player has a direct link to AudioView. With AudioView you
can cut, paste, reverse, add echo or do any number of edits to custom-
ize your own sounds. You can even create sounds from scratch.

You will find the WAV Player, with its recording, playback and editing
capabilities a powerful, easy-to-use sound utility.

Now’s a good time to view the MIDI & WAV Player
Video Tutorial. Make certain the CD-ROM is in the
drive, click Online Video Tutorials, and then click .
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WAV Player Screen

Playlist Modes
—  shows which
play mode is
currently in use.

Current Play
Position —

displays the length
of the file.

Current File — displays
the name of the current

digital audio file.

VU Meter —
displays the digital
audio playback or
recording levels in

real time.

Trk — displays the
number of the file
playing in the playlist.

Play Indicator —
displays when a WAV

file is being played.

Pause Indicator —
displays when the WAV

Player is paused.

Intro Play Indicator —
displays if Intro Play is
selected.

Play Position Slider — enables you
to jump to any part of the current

selection simply by dragging the slider.

Launch
WAV
Editor —
calls up
AudioView.

Play
Mode
Select
button

Playlist
button

Intro
Play

Select
button
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VU Meter Display
The VU Meter is a horizontal display of
“lights” that indicate playback or record
levels.

On the VU Meters:
• For stereo files, separate left and right

levels are displayed.

• For mono files, both meters display
identical levels.

Playing Digital Audio Files
Before you can play digital audio files, you must first create a playlist of
the files you want to hear.

For information on creating a playlist, refer to the
“Playlist” chapter, earlier in this User’s Guide.

To Play Digital Audio Files:

1. Once you have created a playlist, press OK to close the Playlist
screen.

2. Press Play to hear the files in the playlist.
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Recording Digital Audio Files

Record Standby Mode

When the Record button is clicked, it puts the WAV Player
into Record Standby mode. The red light on the Record
button blinks to indicate that the system is ready to record
— but hasn’t actually started recording yet. Now you can:

• Click the Play button to begin recording.

• Click the Record button again to cancel Record Standby.

To Find the Best Volume for Recording:

1. Click the Record button for Record Standby mode.

2. Click the Play button to start recording.

3. Watch the VU meters as you speak into the microphone or play
your sound source.

4. Adjust your mixer’s record level slider and/or your speaking
volume so the red lights blink occasionally at peak volumes.

To Record a Digital Audio File:

1. Use the Audio Mixer to select an input source such as Mic or
CD and set its record level.

2. If you want to record from your CD drive or from an external
source such as a tape deck, cue up the material as needed.

3. Click the WAV Player’s Record button. The red LED will blink,
indicating that the module is in Record Standby mode.

4. Click the Play button to begin recording. Speak into the micro-
phone or start playing the material you have prepared.

5. Click the Stop button when you are done.

6. Click the Play button to hear what you’ve just recorded. You
can follow the above steps to re-record if you wish.
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To Pause During Recording:

• To temporarily stop recording, click the Pause button.

• To resume recording at the point where you left off, click the
Pause button again — or press the Spacebar.

Use only the Pause button or the Spacebar to
resume recording. If you click the Record button,
you will erase the existing recording and start a
new one.

After you have recorded a WAV file with the WAV Player, you should
save it. To save the file, you will need to open AudioView.

Launching AudioView and Editing Digital
Audio Files

The Launch WAV Editor button on the WAV Player
launches AudioView with the current file loaded.

AudioView is AudioStation’s digital audio editor/recorder from
which you can save WAV files and perform common editing
functions such as copy, cut, and paste.

AudioView also offers more sophisticated editing features such as
Mix Paste for making composite files from two or more files and
wave level adjustments for fine tuning playback volumes.

Now’s a good time to view the AudioView Video
Tutorial. Make certain the CD-ROM is in the drive,
click Online Video Tutorials, and then click .
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To Save a WAV file:

1. Click the Launch WAV Editor button to open AudioView.

2. From the File menu, select Save.

3. Select a file format — .WAV or .VOC.

4. Type a new file name in the dialog box.

5. Click OK.

• The VOC format was originally developed by
Creative Labs for their Sound Blaster™
products and is widely supported by other
manufacturers.

• The WAV format was developed by Microsoft
and is used with Windows® applications.

To Edit Files from the WAV Player:

1. Load a Playlist containing the desired file into WAV Player or
create a new playlist. You can also use a file that you have just
recorded.

2. Return to the WAV Player screen and use the Next or Previous
buttons to access the desired file.

3. Click the Launch WAV Editor button to open AudioView with
the current file loaded.

4. Edit and save the file as desired.

For detailed instructions on using AudioView’s
powerful editing features, refer to the “AudioView”
chapter.
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Chapter 12

AudioView

AudioView lets you record and edit WAV files using standard Windows
cut-and-paste techniques. AudioView supports the most popular digital
audio formats for the PC.

With AudioView, you record directly to the hard drive, then use simple,
powerful editing tools to cut, copy, paste, mix paste, and more. Audio-
View’s Drag-and-Drop Audio icon simplifies opening files and embed-
ding WAV files in OLE documents.
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Launching AudioView
AudioView can be launched from its own icon in the Voyetra Audio-
Station program group, from the WAV Player, or from the Voyetra
System Tray Launcher.

Audio View Screen

 

Drag-and-
Drop
Audition
Icon

VU MeterTransport
Controls

Edit
buttons

Graphic File
Display

Zoom
buttons

Select
Range

During
Playing

Program Status

Transforms
buttons

Range Start

Play Range

Range End

Sample Rate

Bits Per Sample

Number of
Current Position
in File

File Duration

Undo
button
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Now’s a good time to view the AudioView Video
Tutorial. Make certain the CD-ROM is in the drive,
click Online Video Tutorials, and then click .

Transport Control Buttons
AudioView uses the same Transport Control buttons as AudioStation’s
Players. For additional information on the Transport Controls, refer to
the “AudioStation Controls” chapter, earlier in this User’s Guide.

You can advance to either the beginning or end
of a file by double-clicking the Rewind or Fast
Forward buttons.

Keyboard Shortcut Keys for AudioView

Transport
Control

Keyboard
Shortcut

Action
It Performs

Spacebar Play

Enter Stop

< Rewind

> Fast Forward

P Pause

R Record
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Range Controls
The Range Controls are located along the top of the AudioView screen.

Many of AudioView’s functions require that you select a range of data.
The Selected Range is defined by its Start Time and End Time. The
Range Start and Range End numericals in the Range Controls area show
the exact beginning and end point of the selected range. You can adjust
these boundaries within 1/100th of a second.

VU Meter
The VU Meter indicates signal (volume) levels during
recording and playback to help you determine the best
signal level.

Select
Range
During

Playback
Play

Range

Range
Start

Range
End
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Edit Buttons

The Edit buttons, located just beneath the Transport Controls, provide
quick access to the more frequently used Edit functions: Cut, Copy,
Paste, Erase, Delete, and Trim.

Transforms Buttons

The Transforms Buttons provide quick access to the more frequently
used Transform functions: Scale, Echo, Noise Gate, Normalize, and
Fade.

Undo
Undo restores the file to the state it was in before the
most recent Edit or Transform operation.

You can use Undo to restore a file if you’ve accidentally chosen New
or recorded over it — as long as you haven’t saved the new material.

Scale

Ech

Noise
Gate

Normalize

Fade

Cut Paste

Copy Erase Trim

Delete
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Zoom Buttons
With the zoom buttons you can see how samples form wave shapes
and even see individual samples.

Zoom In This button provides a magnified view of a
selected range.

Zoom Out This button returns to the previous zoom
level.

Understanding the Graphic File Display
The main section of the AudioView screen is the Graphic File Display.

One of the great advantages of editing with AudioView is the ability to
see sound displayed graphically on the screen. You can see the entire
file or you can zoom in on any part of it — so closely, in fact, that you
can actually see each of the thousands of individual samples that make
up a file.

Graphic File
Display
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The Graphic File Display shows you two characteristics of the sound in
the file: time and amplitude.

Time

The horizontal dimension of the display represents time, moving from
left to right. A ruler just above the display, marked in seconds, displays
time. For longer files, this ruler is marked in minutes.

All of AudioView’s edit functions
and most of the transforms

require that you specify a section
or range of the file that you wish

to edit. When a range is selected,
it appears in reverse video on the

Graphic File Display.

The Play Position Marker is a
vertical line that displays the point
in the file where playback will
begin. During playback, it moves
from left to right across the
Graphic File Display.

The scroll bar along the bottom of the
Graphic File Display moves the Play

Position marker forward or backward.

Ruler
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Amplitude

The vertical dimension of the Graphic File Display shows the amplitude
of each sample in the file. Amplitude is a measure of the strength of the
signal — how much it departs from zero. The amplitude of a single
sample can be any of 256 possible values: It can be positive (from 1 to
127), zero or negative (from -1 to -128). Many samples are strung
together to represent sound waves. Positive amplitudes form the peaks
of the waves; negative amplitudes represent the troughs.

The horizontal axis along the center of the Graphic File Display
represents an amplitude of zero. Each sample extends upward or
downward from this line. Usually, the samples are drawn so closely
together that they form a solid mass with jagged edges. The wider this
mass is from top to bottom, the greater the overall amplitude of the
samples.

Refer to “Using the Zoom Buttons” later in this chapter for information
on viewing different levels of magnification in the Graphic File Display.

Amplitude vs. Volume

Amplitude — corresponds to, but is not exactly the same as
“volume” or “loudness.” Amplitude is a measurement,
expressed as a number.

Volume or loudness  — is a result — it’s what the amplifier,
speakers and other electronic equipment do with the
amplitude.

Amplitude can be expressed as a negative number; audible volume
cannot. No sound can be “less loud” than zero. Amplitude, on the other
hand, can be considerably less than zero (minus 126 for example), and
still be quite strong; (126 of a possible 128 steps away from zero). With
its absolute value of 126, this negative amplitude, when amplified, will
result in a relatively loud sound.
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Overview Bar

The Overview Bar  is a black bar which helps you keep track of your
location within a large audio file. When you Zoom In on a section of an
audio file, the Overview changes size to reflect the size and position of
the zoomed range within the entire audio file.

Refer to the section on “Using the Zoom Buttons”
for more information about zooming in on a file.

To Toggle the Overview Off:

• Choose Overview from the Options menu.
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Status Area

The Status Area located at the bottom of the screen displays information
about the status of AudioView and the current file.

Status Box Displays the current status of the program
(for example, Stop, Play, Record, Drawing)
or the current Transform or Edit control
(such as Normalize, Find Peak, Echo, Cut,
etc.).

Sample Rate (kHz) Is the sample rate. The higher the sample
rate, the better the resolution.

Bit Length Indicates if the audio file is 8- or 16-bit. Note
that 12-bit audio files will be displayed as 16
bit.

# of Channels Indicates whether the current file is stereo
or mono.

Current position Displays the current play position during
recording and playback, in
minutes:seconds.hundredths of a second.

File length Displays the total length of the current file
in minutes:seconds.hundredths of a second.

Status Box

Sample Rate

Bit Length

Stereo/ Mono

Current Position

File Length
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File Menu

New Creates a new, empty file based on the settings in
the Setup window.

• It is not necessary to choose New before
recording.

When you record, AudioView always replaces the
currently loaded file with newly recorded material.

• Choosing New does not erase the contents of
the Clipboard.

Open Presents a dialog box from which you can select the
file you want to load.

• To locate a file with a specific file extension,
choose VOC or WAV from the drop-down list at
the lower left. The default is WAV format
which is used by most Windows applications.

• To hear a sample of a file, click on the filename
to highlight it then click on the Audition
button. To stop Audition playback, click on any
other file.

• To hear sample playback automatically—
without clicking the Audition button—activate
Auto Audition from the Options menu.
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• To load the highlighted file, click OK.

Save Saves the current file to disk. If the file already has a
name, it will be saved with that name. Otherwise,
the Save As... dialog box displays.

Save
As...

Presents the Save As... dialog box, which lets you
enter a new name for the file you want to save. After
entering the desired name for the file, click OK to
save it.

Exit Closes AudioView and returns to Windows.

1/2/3/4
(File List)

The bottom portion of AudioView’s File menu lists
the four audio files that you have opened or saved
most recently. To open a file in this list, click on its
entry or type its number.

Edit Menu

For quick access to many of the functions on
the Edit Menu, use AudioView’s on-screen Edit
buttons.
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Undo Reverses the effect of the last command.

Cut Removes the selected portion and places it on the
Clipboard.

Copy Copies the selected portion to the Clipboard, without
removing the selected data.

Paste Pastes the data from the Clipboard into the currently
loaded file, starting at the beginning of the selected
range.

Mix Paste Combines the data from the Clipboard with the data in
the currently loaded file.

Select All Selects the entire file.

Delete Deletes the selected portion of the WAV file, but does
not place any data on the Clipboard.

Erase Cuts the selected area, leaving silence in its place, and
places the data on the Clipboard.

Trim Deletes all the data that is not currently selected.

Insert
Silence

Inserts the selected amount of silence into the file.

Load File
into

Clipboard

Opens a dialog box from which you can load a file
directly to the Clipboard.

Save
Clipboard

Opens a dialog box from which you can save the data
to the Clipboard as a file.

If you want to cut-and-paste between different files,
you can run several instances of AudioView
simultaneously.
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Transforms Menu
With AudioView, you can add digital effects (transforms) to your entire
file or a selected range of the file.

Normalize Modifies the file’s amplitude and improves its
signal-to-noise ratio. This can be helpful if a file
has been recorded at too low a level.

Find Peak Locates unwanted spikes so that they can be
Scaled or Deleted.

Scale Adjusts the amplitude of a selected range by a
Scale Factor that you select. Scale is very useful
for balancing volumes when cutting and pasting
between different files.
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Fade Creates a smooth “fade in” or “fade out” on the
selected range.

Echo Lets you add custom effects such as reverb,
repeats, resonance, and so on. The Echo dialog
box has two sliders to control Time and Depth,
and four Preset buttons.

Noise Gate Finds every sample in the selected range with an
amplitude below a specified amount and replaces
it with silence. The procedure removes
background noise from the quieter parts of the
selected range.

Invert Samples Changes positive amplitude values to negative
and vice-versa.

DC Offset Centers the display for an audio file that was
recorded with a DC offset.

Matches offsets of audio files after cutting-and-
pasting material from different files.

Reverse Reverse makes the selected range play
backwards. Use the Reverse transform as a
special effect or to create an unusual transition
between music and narration.

Crossfade A single command that combines three tasks:

• A Fade Out on the current file.

• A Fade In on the data on the Clipboard.

• A Mix Paste of the two.

Halve Sample
Rate

Reduces the sample rate of an audio file by half.
This can make the file compatible with sound
cards that cannot support higher sample rates.
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16 - 8 bits Converts a 16-bit audio file to the 8-bit format,
allowing a sound card that supports only the 8-bit
file format to play the file.

Stereo - Mono Combines the right and left channels of an 8-bit or
16-bit stereo file into one channel, creating a
mono file. This transform reduces the file size by
half and permits it to play on sound cards that do
not support stereo.

WAV -> VOC or
VOC -> WAV

Converts 8-bit PCM WAV files to the Sound
Blaster VOC format, or VOC files to 8-bit PCM
WAV format.

Change Speed Changes the sample rate of a file to a new rate
which you select. This transform audibly changes
the speed and pitch of the sound, much like
playing a record or tape player at the wrong
speed. You can choose one of the most
commonly used speeds from the New Sample
Rate list or enter any speed your sound card
supports.
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Options Menu

The Options Menu lets you customize
AudioView.

A check mark appears next to an Option
when it is enabled.

Auto
Audition

Lets you quickly audition a file from the Open or Save
As... dialog box. When Auto Audition is active, clicking
on a filename in the list box starts playback of that file.
The file plays until you click on another file name or
control or until the end of the file is reached.

Auto
Rewind

When Auto Rewind is enabled, AudioView
automatically rewinds to the beginning of the file any
time it stops playing. When Auto Rewind is
unchecked, the play position marker remains at the
point where it has been stopped.

No Wave When enabled, the Graphic File Display disappears
and AudioView’s window shrinks vertically. Use No
Wave to eliminate waiting for screen re-draws, to
reduce system overhead when playing back files at
high data rates, or to make room on your desktop for
other applications.

Ruler Toggles the ruler above the Graphic File Display on or
off. The Ruler measures time in units of seconds,
tenths of a second or hundredths of a second,
depending on how much of the file is displayed.
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Overview Toggles the Overview display on or off. The Overview
provides a visual indication of that section’s location
within the entire file.

Playback VU,
Record VU

Toggles the VU meter on or off. The playback VU
meter monitors signal levels during playback of an
audio file. The record VU meter monitors incoming
signal levels during recording. These meters are
disabled during recording or playback of compressed
files.

Zoom In Provides a magnified view of a selected range. You can
also use the Zoom In button for easier access to this
function.

Zoom Out Returns to the previous zoom level. You can also use
the Zoom Out button for easier access to this function.

View
Entire

Returns immediately to a full view of the audio file
after having zoomed in multiple levels.

If you experience problems playing or recording
files at high data rates, try disabling the VU meters
to reduce system overhead — or your can also
enable “No Wave.”

Enabling and Disabling Options

To Turn On/Off Any of the Items in the Options Menu:

• From the Options Menu, select the item to toggle it on/off.
When the check mark no longer appears next to the entry, it
means that the feature has been disabled.
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Windows Menu

The Windows Menu lets you set different parameters for recording and
playing back your digital audio files.

Setup

Displays the Setup dialog box where you can choose settings for a file
prior to recording.

Setup Dialog Box
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File Format Lets you select WAV or VOC file format. The VOC
format was originally developed by Creative Labs
for their Sound Blaster™ products, and it is widely
supported by other manufacturers. WAV format
was developed by Microsoft and is used with
Windows® applications.

Data Format AudioView automatically detects and lists all of the
data format/compression schemes supported by
your sound card.

Sample Rate Allows you to select a sample rate in Hz.

Stereo Toggles Stereo on and off. (This option appears
only if the sound card supports stereo.)

Temp
Directory

The directory that AudioView uses for temporary
storage when you record, edit or transform digital
audio data.

Work
Directory

This is the default directory that AudioView will
use when opening or saving files.

Clipboard

The Clipboard displays
information about the
contents of AudioView’s
Clipboard.

It also lets you audition the
contents of AudioView’s
Clipboard.
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From The source file from which the data was Cut or
Copied or the name of the file loaded into the
Clipboard.

Sample Range The starting and ending sample numbers,
referenced to the source file from which the data
was Cut or Copied.

# Samples The total number of samples in the Clipboard data.

Duration The duration of the data in the Clipboard in
minutes:seconds.hundredths of a second.

Sample Rate The sample rate of the data in the Clipboard.

Format The bit length and mono/stereo setting of the data
in the Clipboard.

Transport
buttons

Plays only the material currently in the AudioView
Clipboard. Use these buttons to check the contents
of the Clipboard before you paste them into a file.

OK Closes the Clipboard window and returns you to
the main screen.

Data pasted from the Clipboard will play back at
the Sample Rate of the file it is pasted into.
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Wave Color, Background Color, Peak Color

These commands — Wave Color,
Background Color, and Peak
Color — allow you to customize
the Graphic File Display.

Use the Color dialog box to
select colors for the waves, the
background and the peaks of the
waves.

Tune Performance

Tune Performance lets you
optimize AudioView’s
performance or fix
problems you might
encounter during
recording or playback,
especially with high data
rates.

Play Buffer When you play digital audio, AudioView sets aside
a buffer, a portion of your system's RAM, to
momentarily hold data and prevent bottlenecks.

The capacity of the Play Buffer is expressed in
seconds; the default is 4 seconds. If you want to
change the size of the buffer, try increasing its size
in steps of about 2 seconds.



AudioView 123

Record Buffer Sets the amount of time that AudioView sets aside
in your system’s RAM, when recording a digital
audio file, to momentarily hold data and prevent
bottlenecks.

Record Buffer works in the same manner as the
Play buffer. The record buffer's default is 8
seconds. If you have trouble recording, try
increasing the size.

The message "Unable to allocate enough memory”
that you've requested more memory than your
computer can provide. If this occurs, decrease the
size of the Record Buffer.

Pre-Write Sets the amount of memory that the system uses
to prepare for recording.

AudioView creates or pre-writes an unfragmented
file on the hard drive prior to recording. The Pre-
Write setting establishes the size of this file. The
default is 128K. If increasing the Record Buffer
hasn't solved your data rate problem, set a Pre-
Write value slightly larger than size of the file
you'll be recording (in Kilobytes).

Normally, you should change settings in the Tune
Performance dialog box only if you are
experiencing problems. Try other troubleshooting
options before changing any of the default settings.
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File Info

File Info displays a summary of
information about the current
file including:

• File Format

• Data Format

• Sample Rate

• Channels (mono/stereo)

• Number of Samples in the
file

• Total File Size

File Format Displays the format of the loaded file.

Data Format Displays the Data Format of the loaded file.

Sample Rate Displays the Sample Rate of the loaded file.

Channels Displays whether the loaded file is in stereo or
mono.

Samples Displays the total amount of sample in the loaded
file.

File Size Displays the size of the loaded file.
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Digital Audio Data Compression
Digital audio compression reduces the size and storage requirements of
digital audio files. PC sound systems can support digital audio data
compression in hardware, through software products like Microsoft’s
Audio Compression Manager (ACM), or both. AudioView searches your
system for many of the most widely supported compression schemes
and supports any that it finds.

If you are recording a file to be played back on another system or with a
different software application, you may not want to use compression.
Keep these considerations in mind as you decide whether or not to use
data compression:

• Data compression reduces file size partly by eliminating some
data, which inevitably reduces audio quality. In general,
compression is most appropriate for speech or other situations
where high fidelity is not essential.

• Compressed files can be played back only on systems that
support the same compression scheme.

• Not all software applications support playback of compressed
files (even if the sound hardware does).

• AudioView cannot perform any edit or transform functions on
compressed files—that is, anything other than 8- or 16-bit PCM
(Pulse Code Modulation).

• AudioView cannot display the waveform or VU Meters when
recording or playing compressed files. If you have trouble
getting a usable level when trying to record a compressed file,
switch to 8- or 16-bit PCM in the Setup window, use the VU
meters to adjust your record level as needed, then switch back
to the compressed format and record your file.

• Don’t confuse digital audio data compression with other
common methods of compressing computer files:

• Archiving utilities are used for storing inactive files or
sending files with a modem. Files cannot be used while
they are in the compressed state.
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• Hard disk compression utilities create a single, large file
on your hard disk which the operating system treats as a
new disk drive. Compression and de-compression occur
automatically in a process invisible to the user.

To Use a Different Type of Compression:

1. Select Setup from the Windows menu.

2. Click the arrow on the drop-down box for Data Format and
select the format you want.

3. Click OK to return to AudioView’s main screen.

4. Record a file and then save it. The file will be saved in the data
format you selected.

You cannot change the compression of a file that has
already been recorded!
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Help Menu
The Help Menu activates the Online Help system
and provides information about the revision number
and creation date of AudioView.

• Click Index to activate the Online Help system.

• Click About to receive information about the revision number
and creation date.

Playing a File

Auditioning a Digital Audio File

If you would like to hear a file before opening it, you can Audition it.

To Audition a File:

1. Select Open from the File Menu.

2. Navigate to the directory where your digital audio files are
located.

3. Click a filename to highlight it.

4. Click the Audition button.

5. To stop Audition playback, click a different file name.

If Auto Audition is enabled in the Options menu,
you will automatically hear each file as you select
it.
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 Opening and Playing a Digital Audio File

To Open and Play a File in AudioView:

1. Choose Open from AudioView’s File menu.

2. Navigate to the directory where your digital audio files are
located.

3. To open a file, double-click on its filename or highlight the
desired filename and choose OK. After the file loads, a graphic
representation of the audio file fills the Graphic File Display
and the Status indicators along the bottom of the window
display information about the file.

4. To play a file, click the Play button in the Transport Controls
area. The Play Position Marker moves from left to right as the
file plays.

• To halt playback momentarily, click on the
Pause button. Click on the Pause button again
to resume playing.

• In Windows 95, you can load a file by
dragging it directly into AudioView’s Graphic
File Display.
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Choosing a Starting Point for Playback

Playback can begin at any point in the file. To choose a different
starting point, move the Play Position Marker to the desired position
before clicking the Play button. The Current Position Indicator at the
bottom of the screen always shows the exact location of the Play
Position Marker in minutes, seconds and hundredths of a second.
Playback always begins from that point.

To Set the Play Position Marker:

• With your mouse, drag the thumb, the movable square box on
the scroll bar, to approximately the point where you would like
playback to begin.

Click the arrow
to move the Play
Position Marker
by 1/100 of a
second.

Current Position
Indicator

Play Position Marker

Click the arrow to
move the Play

Position Marker by
1/100 of a second.

Drag the
“thumb”
to where
you would
like play-
back to
begin.
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Selecting a Range
All of AudioView’s Edit functions require that you select the section or
range of the file that you wish to edit. If you’ve ever used a word
processor, this concept will be familiar to you. The Range controls
always display the start time and the end time of the selected range.
The selected range appears in reverse video on the Graphic File
Display.

There are several ways to select a range. You can drag your mouse
across part of the Graphic File Display, or select a passage on-the-fly as
you listen. The on-the-fly method is useful when you need to select an
area whose boundaries are not apparent in the Graphic File Display.

A good way to select a precise range is first to
make a rough selection, then fine-tune it. The
Range Start and Range End numericals in the
Range Controls area show the exact beginning and
end point of the selected range, and allow you to
adjust its boundaries within 1/100th of a second.

The Play Range button allows you to listen to the selected range so that
you can verify your selection.
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Moving the Play Position Marker with the Scroll Bar

• To scroll through the audio file, drag the “thumb” (the movable
square on the scroll bar) marker to the left or right.

• To adjust the Current Play Position by one hundredth of a
second, click the right or left arrows at the ends of the Scroll
Bar.

• To adjust the Current Play Position by a tenth of a second, click
on the Scroll Bar anywhere between the thumb and the arrows
at either end.

Selecting a Range

To Select a Range with the Mouse:

1. Click on the desired start point (Range Start) in the Graphic File
Display and, while holding the mouse button, drag it to the
right..

2. At the desired end point (Range End), release the mouse
button.

To Select the Entire Range

• From the Edit menu, choose Select All.

                 ~or~

• Double-click anywhere in the Graphic File Display. The entire
WAV file displays in reverse video.
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To Select a Range as You Listen:

1. Play the file, listening for the position you have chosen as the
start point.

2. When you hear the section you want, click and hold down the
Select Range During Playback button with your mouse.

3. Release the mouse button at the end of the desired section.

4. Click the Stop button.

5. Click the Play Range button to play the selected range.

To Make a Rough Adjustment to the Selected Range:

1. Place the mouse cursor at the desired location in the Graphic
File Display.

2. Press the Shift key and click. The Range Start or Range End
point, whichever is nearer, will jump to the mouse cursor. The
other boundary will not be affected.

To Make a Precise Adjustment to the Selected Range:

• Click anywhere on the appropriate Range Start or Range End
numerical (the displays to the left and right of the Play Range
button) and drag up or down to reach the desired Start or End
time.

                         ~or~

• Click on the upper or lower half of the numerical to adjust the
time by 1/100th of a second.
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When you have selected the range you want, take
note of the numbers in the Range Start and End
marker boxes. If you want to select that range
again, these numbers will help you do so quickly
and precisely.

Zoom Buttons

The Zoom buttons provide quick access to the following menu
commands.

Zoom In Provides a magnified view of a selected
range.

Zoom Out Returns to the previous zoom level. To
zoom all the way out and see the entire
file, double-click the Zoom Out button.

With the zoom buttons you can see how samples form wave shapes,
and even see individual samples. Select a very small range, half a
second or less, and zoom in. You should see a rough pattern of wave
shapes. If you don’t, make another small selection and zoom in again.
After a few zooms, you’ll see a long staircase meandering up and down.
Each step represents a single sample.

Each step is a sample.

Zoom In to see waves. Zoom In further to see
individual samples.
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Using the Zoom Buttons

Zoom buttons allow you to easily zoom in on a selected range and
zoom out again.

To See a Magnified View of the Waveform:

1. Select a range with the mouse.

2. Click the Zoom In button or choose Zoom In from the Options
menu. The range you selected will be enlarged to fill the entire
area of the Graphic File Display.

3. Repeat this process for increasingly higher degrees of
magnification.

To Reduce the View of the Waveform:

• Click the Zoom Out button or select Zoom Out from the
Options menu. Successive Zoom Out commands restore each
of the views you zoomed in on, in reverse order.

To Quickly Zoom Out to See the Entire File:

• Double-click the Zoom Out button or select View Entire from
the Options menu.
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The following section presents a tutorial
on how to use the editing features in AudioView.

Editing a File
With AudioView’s editing tools you can cut, copy, paste, insert, or
delete data within a file or among several files. If you want to cut and
paste between different files, you can run several instances of
AudioView simultaneously.

For this tutorial, use the file EDIT.WAV, which can be found in the
VOYETRA\AS2 directory. This file consists of a short selection of music
followed by some speech. The boundary between the music and
speech portions of the file will be apparent in the Graphic File Display.

Using the Edit Functions

AudioView’s editing functions work just like those in a word processor.
You can cut, copy, paste or delete digital audio data as you would text.
Think of the Start point of the selected range as the “cursor position”.
Data that you cut or copy remains in AudioView’s Clipboard until you
replace it with different audio data or close Windows altogether.

For the following tutorials, be sure to save
the edited file under a new name. Otherwise
you will overwrite the EDIT.WAV file.
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AfterBefore

To Cut a Section of a File:

1. Select the range of the file that you wish to remove. Use the
techniques described in the earlier section, “Selecting a Range”
to select just the speech portion of the EDIT.WAV file.

Use your mouse to select just the speech portion of EDIT.WAV.

2. Click the Play Range button to check the accuracy of your
selection.

3. Choose Cut from the Edit menu or click the Cut button from
the Edit Controls. The selected range is removed from the file
and copied to AudioView’s Clipboard. The part of the file that
remains widens to fill the display.

After you cut the speech, the music expands to fill the display.

4. Play the file to check the results. You should hear the music
but not the spoken words.

SpeechMusic is entered
Click and drag mouse to the right
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Checking the Contents of AudioView’s Clipboard

The data that you just cut is now stored in AudioView’s Clipboard so
you can paste it into a digital audio file. The Clipboard window displays
a summary of information about the data and has its own Play and Stop
buttons.

To Check the Contents of AudioView’s Clipboard:

1. Choose Clipboard from the Windows menu. A window
displays information about the current contents of the
Clipboard.

Clipboard Contents Dialog Box

2. Click the Clipboard’s Play button. You should hear the part of
the file that you just cut.

3. When you’re satisfied that the Clipboard contains the correct
material, click OK to close the Clipboard window.

4. Now we’re going to paste the speech portion back into the file
but in a different location so that it will play before the music.

When cutting or copying data, the information is
saved to AudioView’s own Clipboard — not to the
Windows Clipboard.
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Selecting a Place to Paste

Before using the Paste command, you must designate the point at
which you want the material to be inserted. The Paste command always
inserts the Clipboard data at the Start point of the currently selected
Range.

 If the selected range has no width (that is, its start
and end points are identical), it will not appear in the
Graphic File Display. To see where the Clipboard data
will be pasted, look at the Start Point Indicator to the
left of the Play Range button.

To Paste the Contents of the Clipboard into a File:

1. If you haven’t already done so, use the procedure, “Cutting a
Section of a File” to place some data in the Clipboard.

2. Select a range and adjust its Start point to the location where
you want to paste the data.

3. We want to paste the material at the very beginning of the file.
Place your mouse pointer anywhere in the file and drag all the
way to the left to place the start point at the beginning of the
file. The end point of the selected range has no effect on Paste,
Mix Paste or Insert Silence operations.

Start Point
Indicator
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4. Choose Paste from the Edit menu or click the Paste button. The
contents of the Clipboard will now be inserted at the chosen start
point. Any data after that point will be shifted to the right.

5. Play the file to hear the result.

Using Mix Paste

Many times, in multimedia presentations, you may want to combine
different elements to produce a new sound. This is easy to do with the
Mix Paste command. The Mix Paste command differs from the Paste
command in that it does not push existing data out of the way —
instead it combines the sounds.

If you followed along with the previous section, on pasting the contents
of the Clipboard into a file, your file should now have the speech
before the music.

Next we’ll combine the speech and music with the Mix Paste
command.

Click and drag the mouse to the left to
select a range beginning at 0:00.00, then

Material is pasted from the beginning
of the selected range.

Speech Music
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To Use Mix Paste:

1. Select the range that includes only the speech.

2. Using either Cut from the Edit menu or the Edit Buttons, cut
this section. This copies it into the Clipboard. Notice that the
remaining portion of the file expands to fill in the display.

3. Select a place to paste the data you just cut. For this example,
paste the data about two seconds into the file; that way we can
hear a short musical introduction before the speech begins.
This can be achieved by setting the start time with the Range
Start Marker, to two seconds. For more information on
selecting a range, see the section earlier in this chapter,
“Selecting a Range.”

4. Select Mix Paste from the Edit menu. The speech is now
combined with the music.

5. Play it to hear the effect. You should hear the music begin
immediately and the speech begin two seconds into the file.

You can see the difference in the waveform when the speech is added.
Mix Paste will lengthen the file if necessary.

If you want to create a new file from the Clipboard’s
contents, choose New from the Files menu before
pasting the data.

The speech now
begins here.

Mix Paste
begins here.
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This ends the Editing Tutorial section.
When asked if you want to save the changes to

EDIT.WAV, click “No.”

If you accidentally save the EDIT.WAV or the
XFORM.WAV files with changes, you can open the
original (unedited) files directly from the CD-ROM.

Deleting a Section of a File
There are two ways to delete a section of a file. One way is
by using the Delete command on the Edit menu. The other
is by clicking the Delete button in the Edit button bar.

Delete differs from Cut in that no information is placed on the
Clipboard.

To Delete a Section of a File:

1. Select the range to be deleted.

2. Choose Delete from the Edit menu or click the Delete button.

If you need to Undo the delete, click the Undo button.
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Erasing a Section of a File
Erase cuts the selected range, places it into the Clipboard and
replaces it in the file with silence. You can either use the
Erase command from the Edit menu or the Erase button.

To Erase a Section of a File:

1. Select a range to be erased.

2. Choose Erase from the Edit menu or click the Erase button.

Before erasing

After erasing
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Trimming a File
The Trim function provides an easy way to consolidate part of a file.
This can be useful if there is silence before and after the speech or
music portion of a file, or if you want to extract only a small part of a
file.

The Trim function can be accessed either by clicking the
Trim command on the Edit menu or the Trim button on the
Edit button bar.

The areas that are not
selected are removed.

After using
the Trim
function,
only the
selected

area
remains.
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To Trim a Portion of a File:

1. Select the area you want to keep. The areas outside the
selected portion will be eliminated.

2. Select Trim from the Edit menu or click the Trim button.

When using the Trim function, no data is placed into
the Clipboard. If you wish to undo Trim, click the
Undo button.

Undo
The Undo command allows you to experiment freely with
edits, transforms and special effects knowing that—as long as
you have not saved your file in the interim—you can restore
the file to its previous state. Using the Undo command is
easy!

To Undo the Most Recent Change:

1. Click the Undo button or select Undo from the Edit menu.

2. Play the file or the selected range to verify the results.

You can only Undo the most recent edit or transform
— so whenever you edit your file, play it back to check
the results before you do any further editing.
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Inserting an Interval of Silence in a File

If You Want to Add an Interval of Silence into a File:

1. Select a range and adjust its Start point to the desired location.

2. From the Edit menu, choose Insert Silence. A dialog box
appears with a slider at the left.

The numerical, above the slider, displays
the length of the interval you are about to insert.

You can use either the numerical or the slider
to adjust the value in the box.

3. Enter a time interval in the dialog box.

4. Click OK. A silent interval of the length you specified will be
inserted at the designated Start point. Any data after that point
will be shifted to the right.

 
Silence is inserted at the beginning of the selected range.

Before After
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Loading a File into the Clipboard
With this menu item you can load a file directly into the Clipboard. This
is useful when you want to Mix Paste or append a file.

To Load a File into the Clipboard:

1. Select Load File into Clipboard from the Edit Menu. A dialog box
displays.

2. Navigate to the directory where the file you want to load is located.

3. Click a file to highlight it.

4. Click OK. The file is now loaded into the Clipboard.

Remember, when cutting or copying data, the
information is saved to AudioView’s own
Clipboard — not to the Windows Clipboard!
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Saving a File from the Clipboard
If you have information that you have placed in the Clipboard, and you
now wish to save it as a file, the Save Clipboard command makes it easy
to do!

To Save Data from the Clipboard as a File:

1. Select Save Clipboard from the Edit menu. A dialog box appears.

2. Navigate to the directory where you want to save the file.

3. In the Filename box, type a name for the file.

4. Click OK.
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Recording

Preparing Your System for Recording

Your system must be set up correctly before you can record. You might
want to take the following steps to familiarize yourself with Audio-
View’s setup procedures or to confirm the settings. Once setup is
completed, you only need to repeat this procedure to change settings.

Use the Setup dialog box to configure settings before recording.

To Prepare for Recording:

1. Make certain the audio source (microphone, CD drive, tape
deck, etc.) is ready for recording.

2. Use the Audio Mixer to select an input source and set the
recording volume level. Refer to the “Audio Mixer” chapter for
more information about selecting a source and setting the
volume.

3. From the AudioView Windows menu, choose Setup.

4. Select the desired File Format (WAV or VOC).

5. If you have selected WAV as the File Format, select the desired
data format from the Data Format combo box. Some systems
support one or more types of data compression; if so, they’ll be
listed here.
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6. Choose a Sample Rate from the Sample Rate combo box. You
can choose a sample rate from the list. Higher sample rates
give you better audio quality but also create larger files.

7. Click the Stereo button to select Mono or Stereo. The blue
indicator on the Stereo button lights when stereo is enabled.

8. Check the entries in the Temp Directory and Work Directory.
Make sure that they are valid directories and that there is
enough free disk space to accommodate the file you plan to
record.

9. Choose OK to return to AudioView’s main window.

Adjusting the Signal Level

There are several ways to adjust the level of the incoming signal during
recording.

• Use the Audio Mixer to adjust the level of the incoming signal.

• You might be able to adjust the output volume of the device,
such as a tape player, that is generating the sound.

• If you are using a microphone, you can speak more softly or
loudly or move closer or further away.

• Be sure to check the VU meters from time to time and to re-
adjust volume settings as needed.

You’ll notice that as you record, the VU Meters blink in response. This
is a good time to adjust the level of the incoming signal to get the best
audio quality. The objective is to record at the highest level possible
without distorting the sound:

• If the red indicators light most of the time, the incoming signal
is too loud and the recording will probably sound distorted.
Reduce the volume of the incoming signal.

• If the blue indicators blink consistently and the red ones blink
just occasionally, the record level is about right.
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VU Meters
The VU Meters indicate signal levels during recording and
playback to help you determine the best signal level.
Although their appearance doesn’t change, the VU meter
perform slightly different functions depending on what
AudioView is doing at the time:

• If you’re recording, they display the levels of the incoming
signals.

• During playback, they display the levels of the recorded
material.

• If you are recording or playing stereo, AudioView will display
separate readings for the left and right channels.

• If you are recording or playing mono, both meters show
identical readings.

To Toggle the VU Meter On or Off:

• Choose Record VU or Playback VU from the Options menu.

If you receive the message, “Disk could not keep up
with digital audio file,” try turning the VU Meters off.
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To Ensure You Are Recording at the Best Volume:

1. Click the Record button to place your application in Record
Standby mode.

2. Click the Play button to start recording.

3. Watch the VU meters as you speak into the microphone or
start your sound source.

4. Adjust the Mixer’s record level slider and/or your speaking
volume so that the red lights just blink occasionally at peak
volumes.

To Record a File:

1. If you are recording from a CD drive, CD player, or tape deck,
cue up the material as needed.

2. Click the Record button in the Transport Controls area. The
blinking red light indicates that AudioView is in Record Standby
mode and the word “Standby” appears in the Status Box at the
lower left.

3. Click the Play button to start recording. The red light remains
lit and the word “Recording” appears in the Status Box at the
lower left.

4. Speak into the microphone or play the material you prepared.

5. Click the Stop button to stop recording.

6. Click the Play button to hear your recording.

To temporarily halt recording without losing material
already recorded, click the Pause button. Click the
Pause button again to resume recording..
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Saving Files
So that you don’t lose the work you’ve been doing, it’s always advisable
to save frequently.

To Save a File:

1. Choose Save from the File menu. If the file is new and has
never been saved before, the Save As... dialog box opens.

Save As Dialog Box

2. Select a file type from the List Files of Type box.

3. Type a file name in the dialog box.

4. Click OK.
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Modifying Files with Transforms
AudioView includes many transforms which enable you to modify your
digital audio recordings. These transforms can be accessed from the
Transforms menu, although a button bar containing five of the most
commonly-used transforms appears on the AudioView screen.

You can use transforms to fix certain kinds of problems and to add
interesting effects.

Use the Transforms buttons for quick access to some
of the more commonly-used Transforms.

Usually, you begin by selecting a range. However, you don’t always
need to do this, some transforms affect the entire file.

Next, you select the transform. Some transforms execute automatically,
others present a dialog box in which you make choices or enter values.

The next AudioView
tutorial begins here.

Using Transforms to Fix Problems
For this part of the tutorial, you will need to open the XFORM.WAV file
which was copied to your hard drive by the installation program. We
are going to use some of AudioView’s Transforms to fix the file. First,
we’ll use Reverse to modify the file so that it plays forward.

 If you still have the EDIT.WAV file opened from the
Editing Tutorial section, choose “No” in the prompt
box that asks if you want to save the changes to the
EDIT.WAV file.
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XFORM.WAV

When you load and play XFORM.WAV, you’ll notice that it has several
problems:

• The recorded sound is backward.

• The volume of the file is uneven.

• The overall volume of the file is too low.

Reverse Transform

First, we’ll reverse the file.

To Reverse XFORM.WAV:

1. If you haven’t already done so, load XFORM.WAV and click the
Play button to hear it.

2. Select the range that you want to reverse. Since we want to
reverse the entire file, double-click anywhere in the Graphic
File Display to select the entire file as the range, or you can
choose Select All from the Edit Menu.

3. From the Transforms menu, choose Reverse. Notice the Status
box at the lower left reads, “Reverse.”

4. Click the Play button to hear the file. The speech will now be
understandable.

Before Reverse After Reverse
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Normalize Transform

C A U T I O N !
The Normalize transform can make the file quite
loud. If you’re wearing headphones, remove them
when listening to a file which has been Normalized
until you’re sure that the volume is at a comfortable
level.

Now that XFORM.WAV no longer plays backwards, you’ll notice that it
has an unacceptably low amplitude. You could turn up the volume on
your sound card, amplifier, or speakers to compensate, but that would
also amplify the electrical noise inherent in any electrical circuitry. A
better solution is to leave your volume settings as they are and increase
the amplitude of the samples in the file.

The Normalize Transform does this for you, increasing the file’s
amplitude without elevating electrical noise. The resulting material has
a better signal-to-noise ratio.

Normalize finds the highest level present in the selected range,
converts that level to equal the highest level allowable by the sound
card and scales the rest of the levels proportionately.

The Normalize transform can be accessed either from the
Transforms menu or from the Normalize button which
appears in the button bar on the AudioView screen.

While Normalize can improve the signal-to-noise
ratio during playback, it cannot remove noise that
has been recorded into a file. Use the Noise Gate
transform to learn reduce recorded noise.
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To Normalize Sound:

1. Select the range you want to Normalize. We want to normalize
the entire file so double-click anywhere in the Graphic File
Display or choose Select All from the Edit Menu.

2. Select Normalize from the Transforms menu or click the
Normalize button.

This transform finds the greatest amplitude in the selected
range — in this case, the entire file — increases its value to the
highest value allowed by the sound card, then increases the
amplitude of all the other samples in the same proportion. The
amplitude of the file increases overall, but its original dynamic
proportions are retained.

Normalize increase amplitudes without introducing distortion.

3. Turn down the volume on your sound system and play back
the file. XFORM.WAV should now sound better when played at
a moderate volume.

When using the following tutorials, be sure that
you save the edited file under a new name.
Otherwise you will overwrite the XFORM.WAV file.

Before Normalize After Normalize
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Scale Transform

One problem remains with the XFORM.WAV file — the mismatched
levels between one part of the file and the other. We’ll use the Scale
Transform to match the levels.

The Scale transform can be accessed either from the
Transforms menu or from the Scale button which
appears in the button bar on the AudioView screen.

Scale adjusts the amplitude of a selected range by the factor that you
select. Scale is very useful for balancing volumes when cutting and
pasting between different files.

Scale Transform Dialog Box

The Scale transform allows you to change the amplitude of a selected
range by a scale factor that you specify. For example, a scale factor of
2.0 will double the amplitude; a scale factor of 0.25 will reduce it to
one quarter of its original value. The first part of XFORM.WAV has
roughly half the amplitude of the second so we’ll increase it by a scale
factor of 2.

Any resulting amplitudes that exceed the maximum
level supported by the sound card are set to the
maximum level. If this happens to more than just a
few samples, the sound will probably be distorted. To
avoid this, consider using the Normalize transform.
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To Scale the Loudness of XFORM.WAV:

1. Select the range that you want to scale. The first half of the file
has a visibly narrower amplitude range than the second half.
Use the mouse to select this area and adjust the Range Start and
Range End times if necessary.

2. Select Scale from the Transforms menu or click the Scale
button. The Scale dialog box displays.

3. You can use the slider or the numerical controller to set the
desired Scale Factor. Drag the slider with the mouse to set the
scale factor to 2.00.

4. Click OK.

5. Play back the file to hear the results.
When the Transform is complete, the two parts of the file
should show roughly equal levels. When you play back
XFORM.WAV, its level should sound consistent.

The Scale transform can balance amplitudes that don’t match.

Before Scaling After Scaling

Select this area to be Scaled.
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Name that File
At this point in the tutorial you have altered the XFORM.WAV file so it
plays correctly and clearly. Save this file, in its altered state, with the file
name NEWFORM.WAV, to be used in the tutorial sections which
follow.

It’s time to save XFORM.WAV — but do NOT save it
with the same file name.

1. Open the File menu and click Save As...

2.  In the Filename section of the Save As... dialog
box, enter the name NEWFORM.WAV.

3. Click OK to save the file and close the dialog box.

Creating Special Effects with Transforms

Echo Transform

Echo allows you to add custom effects such as reverb,
repeats, resonance, and so on. The Echo transform can be
accessed either from the Transforms menu or from the
Echo button which appears in the button bar on the
AudioView screen.

This transform presents you with the
Echo dialog box which contains two
sliders, Time and Depth, and four Preset
buttons. You can adjust the Time and
Depth sliders to add a variety of echo-
related effects to a file or you can click
on one of the Preset buttons to quickly
configure the sliders for some of the
more commonly-used echo effects.
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From the Echo dialog box, you can access:

Ambience adds a slight amount of reverberation to make a file
sound fuller.

Stadium adds a spacious reverb effect, similar to a stadium
or a large concert hall.

Resonance adds a distinct resonant frequency (overtone). This
preset creates a robot-like effect when used on
speech.

Long Echo adds a series of repeating echoes with decreasing
volumes.

You can also adjust the Time and Depth  sliders to create your own
custom effects.

Depth determines the reduction in amplitude.

Time determines the delay.
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To Add Effects to NEWFORM.WAV:

1. Double-click anywhere on the Graphic File Display to select
the entire file as the range.

2. Select Echo from the Transforms menu or click the Echo
button.

3. In the Echo dialog box, click the Ambience button. Notice that
the sliders and Numericals adjust to the Ambience settings.

4. Click OK.

5. After the Transform is completed, play the file. You’ll notice
that a small amount of reverberation has been added and the
file sounds fuller.

Use the Undo command to remove the Ambience effect, in order to try
a different Preset. Repeat the procedure above, this time choosing the
Stadium preset. When you play the file, you should hear a reverberation
similar to that heard in a stadium or a large concert hall.

Undo the Stadium transform, and try out the other two presets. Notice
the robot-like quality created by the Resonance setting and the more
natural, outdoor quality of the Long Echo preset. Undo each transform
after you have listened to it.
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The Echo transform, using the Resonance preset.
Notice how the file is extended to the right

to accommodate the echo.

Each time you select a preset button, the Time and Depth sliders on the
left move to different settings. You can adjust these sliders (or the
numericals above them) to create any type of echo you want.

How the Echo Transform Works

To illustrate how the Echo Transform works, we’ve artificially created a
file that has just one sample, isolated in an interval of silence. We used
the Resonance preset to add an echo to this file, generating the new
samples shown at the right.

 
An echo applied to a single sample, using the Resonance preset.

Each sample’s amplitude is 77% as high as the previous one.
The time interval between repetitions is 2/100ths of a second.

This happens to every sample in the selected range.

Before

Before

After

After
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Notice the way the original sample is repeated: each
repetition has a smaller amplitude and each is placed
slightly to the right of the one before.

The Depth slider  determines the reduction in
amplitude. In this example, the amplitude of each new
sample is 77% of the amplitude of its predecessor

The Time slider  determines the delay. Here, each new
sample occurs .02 seconds after its predecessor.

In a real file with many samples, this procedure is
applied to every sample in the file and a Mix Paste
operation merges all the new samples into the existing
file.

Creating Your Own Echoes

By imagining the environment that creates the echo — the reflecting
surface and its distance from the sound source — you can create
realistic echoes easily. An echo, after all, is simply a sound reflected by
a surface of some kind.

The efficiency with which the surface reflects the sound corresponds
to the depth. An efficient sound reflector, like a smooth, hard wall,
would have a relatively high depth setting. A less efficient reflector, like
a grandstand in a stadium filled with people, calls for a lower depth
setting.

The distance between the sound source and the reflecting surface
corresponds to the time. At room temperature, sound travels at about
1,130 feet per second. Some quick arithmetic tells us that it would take
about 2.33 seconds for a sound to make a round trip to a canyon wall a
quarter mile away and back.
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Even using these guidelines, you will probably need to make and undo
several test echoes to get the effect you want. Be sure to play your
results often as you experiment.

Not all echo effects need to be realistic. Generally, for a sound to be
heard as a discrete echo, the delay must be 1/60th of a second or more.
If the repetitions are similar in amplitude and have a short time delay, as
they do in the Resonance echo, they tend to interfere with each other.
The audible result is a pronounced harmonic overtone which produces
the artificial, robot-like quality you hear.

To Create Custom Echo Effects:

1. Load the file you previously saved as NEWFORM.WAV. If you
still have the XFORM.WAV file opened, choose “No” in the
dialog box that asks if you want to save the changes to the file.

2. Select a range. (For this exercise, select the entire file by
double-clicking in the Graphic File Display.)

3. Click the Echo button or choose Echo from the Transforms
menu.

4. In the Echo dialog box, click one of the presets if you wish.
The presets are a quick way to make an initial rough setting.
For this exercise, click the Long Echo button.

5. Adjust the Time and Depth sliders as desired. For this exercise,
try a Time setting of .75, and a Depth setting of 50.

6. Click OK. After the Transform executes, play the file to check
your results.

The time setting of .75 creates a delay of three-quarters of a
second between each repetition. The depth setting of 50
means that the amplitude of each repetition is 50% as high as
the previous one. Notice that the file has lengthened to
accommodate the added echoes. The effect should be similar
to a natural, outdoor echo.
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The echo transform, using the suggested custom settings.
AudioView creates a long extension to accommodate this echo.

You do not need to use the XFORM.WAV file for the
following transforms. Try using a new file to see
what effects the different Transforms can produce.
Remember to save your files under a different name
to preserve the original material.

Find Peak Transform
This transform is useful for
locating an unwanted spike so
that it can be Scaled or Deleted.
This transform scans the selected
range and:

• Locates the largest
amplitude — positive or
negative — within the
selected range.

Find Peak Dialog Box

• Displays a dialog box with information about the peak.

• Selects a two-second range “straddling” the peak.

The Find Peak dialog box contains the following information:

Peak value The absolute value of the peak amplitude, that is, a
negative or a positive amplitude is expressed as a
positive number. For 8-bit files, the value can range
from 0 to 128; for 16-bit files it can range from 0 to
32768.

Percentage The amplitude value of the peak expressed as a

Before After
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of max percentage of the maximum amplitude possible with
the sound card.

Location The location of the peak within the file, in
minutes:seconds.hundredths of a second.

Find Peak selects a new range, with a duration of exactly 2 seconds,
centered on the Peak, and moves the Play Position Marker to the

Peak.

To Find the Peak in a File:

1. Select the range in which you want to locate the peak. If you
want to select the entire file, double-click in the Graphic File
Display or choose Select All from the Edit menu.

2. Select Find Peak from the Transforms menu. A dialog box
appears, containing information about the Peak in the file.

3. Click OK. When you click the OK button in the dialog box, the
transform goes on to :

• Select a new range beginning exactly one second before
and ending exactly one second after the peak.

• Resets the Current Play Position to the point where the
peak occurs.

Selected Area One Second One Second

Peak
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Fade Transform
Fade creates a smooth “fade in” or “fade out” on the selected range.
There is no simple rule for determining the best type of fade and
curvature. Use the Undo command to experiment with different Fade
settings until you achieve the effect you want.

The Fade transform can be accessed either from the
Transforms menu or from the Fade button which
appears in the button bar on the AudioView screen.

To Create a Fade:

1. Select the range you wish to apply a fade to.

2. Select Fade from the Transforms menu or click the Fade
button. The Fade dialog box opens.

3. Select Fade In, or Fade Out.

4. Select how the fade will be produced — Linear, Fast
Exponential or True Exponential.

5. Select the amount of the curve by adjusting the numerical in
the Exp. Curve box.

6. Click OK.
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Fade Dialog Box

Fade Dialog Box

The dialog box for the Fade transforms contains the following
elements:

Fade In — Creates a smooth transition from 0 upward, to the original
ending level of the selected range.

Fade In creates a gradual increase in amplitude (volume).

Fade Out — Creates a smooth downward transition, from the original
starting level of the selected range to 0.

Fade Out gradually reduces the amplitude to zero.

Before

Before

After

After
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Linear  — A Linear fade creates a “straight-line” transition, as follows:

The simplest types of fades are Linear.

Fast Exponential  — A Fast Exponential fade creates a roughly curved
transition.

True Exponential  — A True Exponential fade is smoother than Fast
Exponential but takes longer for your PC to calculate.

Exponential fades are curved to create a more natural effect.

Notice that the Fast Exponential curve isn’t as smooth as the True
Exponential curve. The Fast Exponential is considerably easier for
your PC to calculate and the difference between the two is usually
not audible.

Theoretically, the True Exponential fade reflects more accurately
the way in which the human ear responds to sound pressure levels,
and should sound more natural. In practice, however, this depends
on such factors as the nature of the recorded material, the sound
card you are using and the type of effect you want.

Fast Exponential True Exponential

Fade In Fade Out
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Exp Curve Lets you set the degree of curvature for Fast Exponential
or True Exponential fades. The greater the curvature
value the more abrupt the fade will be, as illustrated
below:

By changing the value for the Exp Curve, you can control
how abruptly a fade takes place.

There is no simple rule for determining the best
type of fade and curvature. Use the Undo
command and experiment with different Fade
settings until you achieve the effect you want.

Noise Gate Transform
Noise Gate finds every sample in the selected range with an amplitude
below a specified amount, and replaces it with silence. The procedure
removes background noise from the quieter parts of the selected range.

The Noise Gate transform can be accessed either from the
Transforms menu or from the Noise Gate button which
appears in the button bar on the AudioView screen.

Exp. Curve=2 Exp. Curve=7
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To Reduce the Background Noise From a File:

1. Select the range from which you want to remove the noise.

2. Select Noise Gate from the Transforms menu or click the Noise
Gate button. A dialog box opens.

Noise Gate Dialog Box

3. Use the slider or the numerical to select a percentage of the
peak amplitude. The transform acts on any sample whose am-
plitude is below that level. Any noise below the level selected
is removed. For example, if you select 10, any sample with an
amplitude of 12 or less (10% of the maximum possible ampli-
tude of 128) is replaced by a sample with an amplitude of 0.

4. Click OK to begin the transform. As the transform is working,
Noise Gate displays in the status box at the lower left.

The Noise Gate transform removes low-level background noise.
Notice how there is no longer any noise on the selected area.

The Noise Gate transform is intended to remove
unwanted background noise but, if you set the
percentage too high you may also remove sounds you
wish to keep. Use the Undo command to help test this
transform until you are satisfied with the results.

Before After
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Invert Samples Transform
Invert Samples changes positive amplitude values to negative and vice-
versa. In the Graphic File Display, the selected range will appear upside
down, but the effect of the change is usually not audible.

To Invert Samples:

1. Select the range you wish to invert.

2. Select Invert Samples from the Transforms menu. The sample
is inverted. Notice, in the following diagram, how this affects
the file.

 Invert Samples can be used to align the visual appearance of two
different audio files after using cut-and-paste.

Before After
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DC Offset
Occasionally, when recording, the
WAV file may not align correctly on
the digital zero point. This can create
an annoying popping sound which is
usually audible at the beginning or
ending of a recording. This sound
occurs because there is a
discrepancy between the last value
of the WAV file and its zero point.

Use DC Offset to:

• Center the display for an audio file that was recorded with a
DC offset.

• Match offsets of audio files after cutting and pasting material
from different files.

To Use DC Offset:

1. Select the range you wish to offset.

2. Select DC Offset from the Transforms menu. A dialog box
appears.

3. Using either the slider or the numerical box, select the amount
of offset. You can select numbers from -127 to 127. A positive
number shifts the range up, a negative number moves it down.

4. Click OK.

DC Offset moves the selected range up or down.

Before After
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Crossfade
Crossfade is a single command that combines three tasks:

• Fade Out on the current file.

• Fade In on the data in the Clipboard.

• Mix Paste of the two.

To Crossfade Two Audio Files:

1. Load the file you want to Fade Out with into AudioView.

2. Load the material you want to Fade In with into the Clipboard.
Use the Load File Into Clipboard command in the Edit menu to
do this.

Start with one file in AudioView and one in the Clipboard
(The Clipboard data, on the right, will not be displayed

on your screen).

3. Select the range where you want the Crossfade to occur
(normally at the end of a file). The crossfade will occur over
this interval .

4. From the Transforms menu, choose Crossfade. The two audio
files will be mixed and pasted together to create a smooth
transition.

File in AudioView File in the Clipboard
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Select the area where you want the fade to occur, then Crossfade.

To use the Crossfade transform, the data from the two
files, the one in AudioView and the one in the
Clipboard, must be compatible. That means, they
must have the same sample rate, number of bits, and
both have the same number of channels (stereo or
mono).

Global Transforms

AudioView contains five global
transforms. These act on the entire
file; you do not need to specify a
range.

To Use Any of the
Global Transforms:

• Select the transform you would
like from the Transforms
menu. As the transform is
working, you will see its name
in the Status box in the lower
left corner.

Before After
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As a precaution, make a backup copy of your audio
file before using any of the Global transforms.

Halve Sample Rate  — This transform reduces the sample rate of an
audio file by half. This can make the file compatible with sound
cards that cannot support higher sample rates.

The process deletes data to create a smaller file and results in some
loss of fidelity. If the new sample rate is lower than the sound card
can support, the transform converts it to the lowest default sample
rate allowed by the card.

16 - 8 bits  — This sample converts a 16-bit audio file to the 8-bit format,
allowing a sound card that supports only the 8-bit file format to play
the file. This process reduces the file size.
There may be some loss of fidelity when using this transform.

Stereo - Mono  — This transform combines the right and left channels
of an 8-bit or 16-bit stereo file into one channel, creating a mono
file. It also reduces the file size by half which permits it to play on
sound cards that do not support stereo.

This transform can only work on a stereo file. If the file is not
stereo, this transform is unavailable.

WAV -> VOC or VOC -> WAV  — This transform converts 8-bit PCM
WAV files to the Sound Blaster VOC format, or VOC files to 8-bit
PCM WAV format.

This transform displays WAV -> VOC or VOC -> WAV depending on
what the current file type is.
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Change Speed  — This transform changes the sample rate of a file to a
new rate which you select. This transform audibly changes the
speed and pitch of the sound, much like playing a record or tape
player at the wrong speed. You can choose one of the most
commonly used speeds from the New Sample Rate list, or enter any
speed your sound card supports.

Change Speed Dialog Box

To Change the Speed of a File:

1. Select Change Speed from the Transforms menu. A dialog box
appears containing the Current Sample Rate and the New
Sample Rate.

2. Click the arrow on the drop-down box to display the available
sample rates and then select a new sample rate.

3. Click OK.

• By choosing a sample rate lower than the
Current Sample Rate, the speed of the file is
lowered.

• By choosing a sample rate higher than the
Current Sample Rate, the speed of the file is
raised.
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Understanding Object Linking and
Embedding (OLE)

AudioView can take advantage of Object Linking and Embedding (OLE).
OLE enables you to place information from one application into a
document created by another application, even if the two applications
use very different types of data. You might not normally think of
placing sound in a spreadsheet, but if the spreadsheet supports OLE,
you can!

Servers and Clients

An OLE application can be a server, a client, or both.

Applications which create objects that can be embedded or linked into
other applications are called OLE servers. AudioView is an OLE server.

Applications that can contain embedded or linked objects are called
OLE clients. Major Windows applications such as Word and Excel
function as clients in an OLE transaction.

Linking vs. Embedding

Linking and embedding are different ways of placing data objects into
clients. In either case, an icon appears in the client to represent the
object. You click the icon to activate the object, for example, to hear a
linked digital audio file. Linked and embedded objects are deceptively
similar in function and appearance. You should understand the
important differences between the two.

• When you embed an object in a client, you create a unique
copy of that object which is saved as a part of the client
document. Any changes you make apply only to that single
instance of the object; copies embedded elsewhere remain
unaffected. Because every embedded object is an independent
copy, embedding can consume a lot of disk space.
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• When you link an object to a document, all you really do is
place a reference, or link, to the original object in the client
document. Thus you only need one copy of the object, no
matter how many times it appears. This saves disk space, but
any changes you make to the object are automatically reflected
in every client document that contains a link to the original —
something you may not always want.

Using the Drag-and-Drop OLE Icon

AudioView’s unique drag-and-drop OLE (Object
Linking and Embedding) icon offers a quick, intuitive
way to embed sound objects into documents created
by other applications — even applications which
don’t normally support sound.

The documents into which you place sound must be an OLE client. If
you are not familiar with this, consult your Windows documentation
before you continue.

• AudioView is an OLE server. This means you can embed or link
AudioView sound objects into documents created with any
OLE client.

• You can use AudioView to edit sound objects from within the
client document.

• When you have linked or embedded a sound object, a copy of
the AudioView icon serves as a place holder in the appropriate
point in the OLE client.
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To Embed a Sound File in a Document:

1. Load or record the desired sound file into AudioView.

2. Drag AudioView’s drag-and-drop OLE icon to the desired point
in the destination document and release the mouse button.

Drag-and-drop the AudioView OLE icon
into the word processing document.

To Embed a Selected Part of a Sound File:

1. Load or record a sound file in AudioView.

2. Highlight the desired range in the Graphic File Display.

3. From AudioView’s Edit menu, choose Copy or click the Copy
button.

4. Click on the desired insertion point in the destination
document.

5. From the client document’s Edit menu, choose Paste.
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To Link a Sound Object:

1. Load or record the desired sound file into AudioView.

2. Make sure the file is saved.

3. Select any part of the file. (This procedure creates a link to the
entire file, so it doesn’t matter what you select, but you must
select something.)

4. From AudioView’s Edit menu, choose Copy.

5. Click on the desired insertion point in the destination
document.

6. From the client document’s Edit menu, Choose Paste Link.

Be aware that if you give someone a file that
contains a link, you must remember to provide the
linked object(s) as well!

To Play an AudioView Sound Object:

• In the client document, double-click the AudioView icon
representing the sound object you wish to play.

                                            ~or~

• Another method is to select the AudioView icon and choose
Sound [VOY] >> Object, Play from the document’s Edit menu.

 Some OLE clients implement OLE functions
differently. Check the client application’s
documentation for details.
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To Edit an AudioView Sound Object:

1. In the client document, select the AudioView icon representing
the sound object you wish to edit.

2. From the client’s document Edit menu, choose Sound [VOY]
Object >> Edit. AudioView starts, with the sound object
already loaded.

3. Edit the sound object in AudioView as desired.

4. Update the sound object in the client document:
If you’re editing an embedded sound object, choose Update
[application name] from AudioView’s File menu.

If you’re editing a linked sound object, choose Save
from AudioView’s File menu. This will overwrite the
original sound file.
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Chapter 13

MediaCheck
MediaCheck™ provides an easy way to test and troubleshoot the digital
audio and MIDI features of your computer. A series of displays takes
you through the testing process step-by-step. If, for some reason, one of
the multimedia devices on your computer is not working properly,
MediaCheck provides troubleshooting tips to help you get your system
up-and-running again.

MediaCheck also provides setup tips for attaching an external MIDI
keyboard to your computer — and a video to show you how to make
these connections. Once the MIDI cable is installed, you can use
MediaCheck’s MIDI Input and MIDI Output tests to confirm that your
system is operating properly.

When troubleshooting a multimedia computer, it is often necessary to
view the installed sound card drivers if changes need to be made to the
drivers’ configuration. Locating these drivers can be quite difficult. The
Advanced button in MediaCheck calls up SoundCheck,™ an advanced
multimedia troubleshooting utility, which displays a detailed listing of
all of your computer’s sound card drivers. From here you can access
the drivers’ configuration dialog box and view status information. This
tells you whether or not the driver is working properly. SoundCheck
also provides access to the Windows MIDI and Sound Mapper
applications.
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MediaCheck Main Screen
Here’s an overview of the main screen in MediaCheck. Note that
clicking the Advanced button calls up SoundCheck, which takes a more
detailed look at your system.

Using MediaCheck
With MediaCheck, you can run a complete test of your multimedia
devices or individually test the specific multimedia functions you are
having trouble with. For example, you may want to perform a complete
test before your run a multimedia application or you may only want to
run the MIDI Input Test if you just hooked up an external MIDI key-
board to your PC and want to make certain it is working properly.

Click to view
Setup Tips and
to view a video

tutorial on
connecting a

MIDI keyboard

Click
to

test
Digital
Audio

Click
to test

MIDI
Input

Click to
test MIDI
Output

Click to test
the Internal
Synthesizer

Click to
begin testing

your
multimedia

Click
“Advanced”
to run
SoundCheck

Click for
online help
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Setup Tips
The Setup Tips section includes a video which demonstrates how to
connect the MIDI cable to your PC and MIDI keyboard.

To View Setup Tips:

• Click the Setup Tips button located at the bottom of the screen.

For additional information on connecting your
MIDI keyboard to your PC, refer to “Making the
Connections” in the “Up and Running” chapter.

Running the Complete Test
The complete test checks Digital Audio, MIDI Input, MIDI Output, and
Internal Synth.

To Run the Complete Test:

1. Click the Begin button on the main screen. MediaCheck
automatically takes you step-by-step through the various tests.

2. In each test, you are prompted with questions to help
determine that your system is working correctly. Click the
appropriate answer for each question.

Running a Specific Test
If you only need to test one function — for example, Digital Audio or
MIDI Input or Output — there’s no need to run a complete test. In
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Digital Audio WAV Test

The Digital Audio WAV Test provides a quick check of the digital audio
playback capabilities of your multimedia system.

To Run the Digital Audio WAV Test:

1. Click the Digital Audio WAV Test button at the bottom of the
screen. This will play a digital audio file.

2. When asked if you can hear it, click either Yes or No.

3. Your answer determines the next course of action.

• If you choose Yes, MediaCheck assumes that your system
is functioning properly.

• If you choose No, MediaCheck suggests several trouble-
shooting tips. Try these tips. If one of these works, you
should hear the WAV file. If none works, click the
Advanced button for more information about your
system’s WAV drivers.

MIDI Input Test

The MIDI Input Test provides an easy way to check that MIDI data is
being received from an external source — such as a MIDI keyboard.

To Run the MIDI Input Test:

1. Be sure your MIDI keyboard is connected to your computer.

2. Click the MIDI Input Test button at the bottom of the screen.

3. Click the correct answer for the questions asked.

• When the keyboard is played, one of the 16 lights should
illuminate. For example, if the keyboard is transmitting
on MIDI Channel 1, the Channel 1 light illuminates.

• Each of the 16 lights represents a MIDI input channel.
This helps you determine which channel your MIDI
keyboard is transmitting on.
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• If none of the MIDI input lights turn on when you play
your synth, click the No button and follow the
troubleshooting tips.

MIDI Output Test

The MIDI Output Test provides an easy way to check that MIDI data is
being transmitted successfully from your computer to an external
source — such as a MIDI synth.

To Run the MIDI Output Test:

1. Be sure your MIDI keyboard is connected to your computer.

2. Click the MIDI Output Test button at the bottom of the screen.

3. When asked if you can hear the MIDI file, click Yes or No.

• If the synth is turned on and connected properly you
should hear music coming from the synth.

• If you cannot hear music playing from the synth, click the
No button and follow the troubleshooting tips.

MIDI Drum Sounds

MIDI files transmit their information on different channels, and each
channel is usually assigned a different musical instrument sound.
Typically drum sounds are fixed to either channel 10 or channel 16.
This can sometimes cause a problem.

For example, a game may play a MIDI file with its drum information
programmed on channel 16, but the internal synthesizer is set to play its
drum sounds on channel 10. This would cause the music to sound
strange. Usually the multimedia application provides a way to fix this.

MediaCheck can help by confirming which channel your computer’s
internal synthesizer has drums mapped to.
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Internal MIDI Synthesizer Test

Most multimedia computers have a MIDI synthesizer built in. This
enables games and other multimedia applications to play music.

To Run the Internal MIDI Synthesizer Test:

1. Click the Internal MIDI Synthesizer Test button. A MIDI file
plays a drum part on channel 10.

• If you hear drums, click Yes and move on to the next
test.

• If you hear a sound like a “piano playing a strange
melody,” click No.

2. When you click No, MediaCheck plays a MIDI drum part on
channel 16. If you don’t hear anything at this point, there may
be a problem with the internal synthesizer in your system or its
drivers.

3. Follow the on-screen instructions for information on how to
resolve this type of problem.

Test Results

As the test advances, MediaCheck provides feedback. This information
appears beneath the test button.

Test Passed Indicates your system is working correctly.

Test Failed Indicates your system is not working correctly.

Not Tested Indicates that test has not been run yet.
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Advanced Button
The Advanced button in MediaCheck launches SoundCheck, which
takes a more detailed look at your multimedia hardware and software.
SoundCheck displays all of the sound card drivers currently installed on
your system along with the status of each. This information helps
determine if there is a problem — such as an address or interrupt
conflict — with the hardware or software.

To Launch SoundCheck:

• Click the Advanced button at the upper right of the screen.

Do NOT wear headphones when using SoundCheck!
Running the tests in SoundCheck can cause sudden
volume increases.

SoundCheck Screen
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Testing Digital Audio

To Test Digital Audio Output:

1. Click the Test Output button, in the Wave Drivers section, to
play a pre-recorded test file.

2. A dialog box asks whether the file is playing. If there is no
sound, check the most likely sources of problems:

• Speakers are connected incorrectly.

• Low sound card volume setting.

• Speakers or other amplified source is not turned on or
the volume setting is too low.

To Test Digital Audio Input:

If you are not able to record sound, the problem could simply be bad
connections or your drivers may be set up incorrectly. Follow these
steps to isolate the problem:

1. Connect a microphone or other device — such as a tape deck
— to the appropriate input on your sound card.

2. Use the Mixer utility that came with your Sound Card to select
the input device and set the volume level.

3. Click the Test Input button in the Wave Drivers section. The
Wave Input Test dialog box opens.

4. Click the Record button.

5. Speak into the microphone for a few seconds — or play a few
seconds of the tape.

6. Click the Stop button in the dialog box to stop recording.

7. Click the Play button to hear the results. If you don’t hear
anything, continue on to Configuring Digital Audio.
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Configuring Digital Audio

Before you make any changes to your Wave Driver’s
configuration, consult your sound card manual.

To Configure Digital Audio:

• Click the Configure button in the Wave Drivers section.
SoundCheck displays a dialog box enabling you to change the
configuration of the currently-selected driver.

You should change the driver configuration ONLY if
you have a problem. Most often, you need to restart
Windows for any changes to take effect. If you do not
restart Windows, click the Refresh button so that
SoundCheck can recognize the new configuration.

Testing MIDI Output

To Test MIDI Output:

• Click the Test Output button in the MIDI Drivers section. The
MIDI Output Test dialog box opens. From here you can play a
Base Level, Extended Level or Dual Arrangement MIDI test file.
This helps determine which MIDI setup is best for your system.

Unless you have selected it for testing, SoundCheck
bypasses the MIDI Mapper and sends MIDI data
directly to the device driver. This helps you distin-
guish between incorrect MIDI Mapper settings and
problems with the driver software.
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Testing MIDI Input

The MIDI Input Dialog Box

To Test MIDI Input:

• Click the Test Input button in the MIDI Drivers section. This
opens the MIDI Test Input dialog box.

MIDI input testing allows you to quickly determine:

• If MIDI data sent from a MIDI device is reaching your
computer.

• On which channel MIDI data is being received.

A row of 17 LEDs appears in the MIDI Input dialog box.
The first 16 correspond to the 16 MIDI channels; the
17th LED, the one at the far right labeled “Misc,” is for
non-note MIDI messages that are not channel-specific.
As you play a synthesizer or other MIDI device, one or
more of the LEDs flash to indicate when MIDI data is
being received and on which channel.
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 MIDI

To Configure MIDI:

• Click the MIDI Mapper button to open the Windows MIDI
configuration utility.

In Windows 3.1:

• It opens the MIDI Mapper.

In Windows 95:

• It opens the MIDI Properties dialog box.

Use either utility to choose an appropriate setup for your MIDI output
device, edit an existing setup or create new ones. As a general guide:

• Base Level synths, typically the earlier FM synthesis sound
cards, only use channels 11 through 16, with drums on channel
16.

• Extended Level synths, typically better FM synthesis sound
cards, use channels 1 through 10, with drums on channel 10.

• General MIDI synths, typically wavetable synthesis sound cards
or external high-end keyboard systems, use all 16 MIDI
channels, with drums on channel 10.
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Testing CD Audio
A message in the status box in the CD Audio section tells you whether
or not MSCDEX was detected. If it is detected, a second message
informs you of the status of the Windows MCI CD audio driver. If
SoundCheck tells you that MSCDEX was not detected, refer your CD-
ROM drive’s manual for the proper installation of MSCDEX.

To Test CD Audio:

1. Place a disc with audio tracks in the CD-ROM drive. Use a
commercial CD recording — the kind you buy in a record
store.

2. Check your mixer settings. Be sure that the CD-ROM drive is
selected and that the volume is turned up enough.

3. Click the Test button to play a CD Audio track.

Summary Button
The Summary screen displays an overview of your system’s audio
capabilities. You can also run a speed diagnostic of your system from
this screen.

Not all sound cards actually play at precisely the same sample rate.
SoundCheck can measure how accurate the playback of your sound
card is.

At the bottom of this screen is the Wave Sync button. This runs a
diagnostic to test the actual sample rates of your sound card.

To Run a Speed Diagnostic of Your System:

1. Click the Summary button to open the Audio Capabilities &
Related Data screen.

2. Click the Run button to test your system’s speed.
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Log Button
The Log button opens Notepad and creates a log file containing
extensive configuration information.

This file contains data generated during testing that can be useful to you
and to tech support people.

Wave Sync
Wave Sync tests your hardware’s ability to accurately synchronize
digital audio and MIDI.

It is only necessary to use Wave Sync if you are
working with applications that have this option —
such as Voyetra’s Digital Orchestrator Plus.™

To Test Wave Sync:

1. In SoundCheck, click Summary to display the Audio
Capabilities & Related Data dialog box. Then click WaveSync.

2. Choose the Wave Out Device. (This is how sound will be
played out of your sound card. Usually you will see the name of
the sound card displayed in this box.)

3. Select the Sample Rate to test.

4. Click the Start button.

5. When you are done, also check the Wave In Device by
selecting “None” for Wave Out and selecting the sound card
for Wave In.

You will notice numbers calculating. Note that this may take a LONG
time.
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Here’s an explanation of the terms used in the Wave Sync test:

Elapsed Time Is a measure of how much time has passed, in
milliseconds, since you clicked the Start button.

Actual Sample
Rate

Is the true sample rate of the sound card. As time
passes, the accuracy of this number increases. You
will be able to see the Actual Sample Rate number
begin to stabilize as time goes on.

Deviation Is the running margin of error that your sound card’s
drivers may produce.

What the Deviation numbers mean:

Between 0 and 10 Excellent for synching digital
audio and MIDI.

Between 11 and 50 Good for synching digital
audio and MIDI.

Between 50 and 500 Fair (it may be a bit unstable)
for synching digital audio
and MIDI.

Over 500 Synching digital audio and
MIDI will not work.

Be aware that many sound cards have a very low Wave Out deviation
and a high Wave In deviation.

The timing of digital audio playback is handled solely by your sound
card driver. If you have a multimedia program that synchronizes digital
audio with another function — such as MIDI to WAV — it must ask the
sound card exactly where into the playback of the WAV file it is at any
moment. This information is gathered by the application communicat-
ing with your sound card’s WAV driver. This information is then used to
calculate at what point the WAV file should sound. If there is a large
discrepancy in this number — where the sound is and where the sound
card driver thinks it is — the application will not play the sound at the
correct moment. This can result in an out-of-sync playback.
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Appendix A

Overview of MIDI and
Digital Audio

MIDI, an acronym for Musical Instrument Digital Interface, is a system
for encoding, sending and receiving the electronic messages which
control MIDI devices. Anything that generates or responds to MIDI
messages is a MIDI device. Common MIDI devices are electronic
musical synthesizers (synths), keyboards, and drum machines. MIDI
commands can also control more specialized devices, such as theatrical
lighting systems. A sound card installed in a computer can also be
programmed to respond to MIDI commands.

MIDI is not a product or a tangible object; it is a specification — a
widely accepted system of rules — introduced in the early 1980s by the
MIDI Manufacturers Association. These rules specify how MIDI data
should be encoded and sent among MIDI devices. They also govern
hardware issues such as the design of the cables and connectors used
by MIDI devices.

A series of MIDI commands can be organized in a deliberate way to
instruct a MIDI synthesizer to play a musical passage. This series of
commands is called a sequence and a hardware device or computer
software program that creates and edits sequences is called a
sequencer. With sequencer software, your computer can record, edit,
or play MIDI sequences and save them as files on a disk. The collection
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of commands in a file — the sequence — then instructs a synthesizer to
play the music.

A single MIDI sequence can control a number of MIDI devices —
virtually an entire synthesized orchestra. This requires certain proce-
dures to keep things organized. For example, to ensure that each
command reaches the correct device, each MIDI command includes an
instruction that assigns it to a MIDI port. If a command is assigned to
port 1, only the MIDI device attached to port 1 receives the command.

Each command routed to a given port is also assigned one of 16 MIDI
channels. Like a television, a MIDI device receives incoming signals on
all channels, and can be set to respond only to selected channels. A
synthesizer differs from a TV, however, in that it can “tune in” more
than one channel at a time.

Each channel is assigned a patch — an instruction that tells the syn-
thesizer to generate a particular type of instrumental sound for that
channel. So, for example, if you have assigned an oboe sound to port 2,
channel 4, any note directed to port 2, channel 4 will sound like an
oboe — until you change the patch assignment.

MIDI commands can trigger two kinds of events: note events and non-
note events. A note event is the equivalent of pressing a piano key. It
instructs the synthesizer to play a particular pitch at a precisely defined
time. The command can convey musical nuances as well, such as how
hard a piano key is struck, held down, or released. However, not all
MIDI devices are designed to respond to this type of information.

Non-note events — sometimes called controller events or simply
controllers — manage other functions of the MIDI device. They may,
for example, adjust the volume or assign a new patch to one of the
channels.

A MIDI file does not actually contain sound. Rather, it is a set of instruc-
tions that tell a synthesizer which sounds to make and when to make
them. In this sense, a MIDI device is like a player piano and a MIDI
sequence is like the perforated paper roll that controls it. If one of the
holes instructs the piano to play the middle C key, the piano will do so.

The ultimate result, however, depends upon the quality and condition
of the piano. If the middle C string is tuned to E-flat, you will hear E-flat.
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This sort of problem can occur with synthesizers, too, but the potential
for error is even greater, since they can simulate so many different
instruments.

Early Problems with MIDI
When it was first released, the MIDI specification attempted to strike a
balance between standardization and versatility. MIDI manufacturers,
software programmers, and composers agreed on certain basic
commands, but other parts of the specification were less rigidly
defined. With everyone free to play by their own rules, fundamental
problems soon emerged:

File Format Though MIDI software programs could send and
receive MIDI commands, each developed its own
way of storing sequences on computer disks, so a
MIDI file could be played only by the program that
created it.

Patches The commands that tell the synthesizer which
patches (instrument sounds) to use are really just
numbers. Standardizing a numbering scheme was
simple enough — patch numbers run from 0 to 127.
But no rules governed which sound went with which
number. Consequently, the part composed for violin
on one synthesizer might sound like a trumpet when
played on another.

Capabilities
of the

Synthesizer

All hardware has inherent limits; a synthesizer can
only make a certain number of sounds, and more
importantly, it can only play a limited number of
notes at once. These capabilities vary widely. A
sequence created on a relatively powerful synthesizer
— one that can simultaneously generate many notes
and instruments — can overwhelm a lesser
synthesizer.

These problems multiplied as the market grew. Patch and drum maps
varied from one synthesizer manufacturer to another, or even among
different models from the same manufacturer. The initial goal of MIDI
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— device-independent MIDI files that would play on any MIDI
synthesizer — began to fade from view.

Working Toward Compatibility
To help composers create device-independent MIDI files, a number of
organizations are at work to establish more fully-defined conventions.
The MIDI Manufacturing Association has offered a specification called
General MIDI (GM) which standardizes, among other things, instrument
and drum sounds. The Multimedia PC Marketing Council, or MPC,
divides synthesizers into two types — Base Level and Extended Level —
so composers can tailor their arrangements to the differing capabilities
of synthesizers.

Even if composers and manufacturers were to adopt a new standard
today, incompatibility problems would remain for most of the MIDI
devices and files already in use. As an interim solution, Microsoft
created the MIDI Mapper — a software utility for Windows 3.1 that
translates MIDI data as it is played, allowing newer files to work with
older synthesizers.

With the release of Windows 95, Microsoft has replaced the MIDI
Mapper with the MIDI Configuration utility. For more information on
the MIDI Mapper and the Windows 95 Configuration utility, refer to
their respective sections later in this chapter.

MIDI Terminology
What happens when a key on a MIDI keyboard is pressed? How is a
MIDI command translated into the correct sound and routed to the
correct destination? How is the sound created? The following section is
designed to help you understand the fundamentals of synthesized
sounds and how they are built into an entire composition.

We hope that these definitions are helpful to you as you begin to work
with MIDI software.
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Voices and Polyphony

Let’s start with the most basic resource in a synthesizer, a voice. A
voice is the electronic circuitry that can make a relatively simple sound.
A synth that has more than one voice is said to be polyphonic. A
synthesizer’s polyphony — the number of voices — is a fundamental
characteristic that establishes its capabilities. Virtually all synths made
today are polyphonic.

Instruments and Timbre

A synth combines one or more voices to create an instrument — a
sound that you hear and recognize, such as a piano, violin, tuba, or
possibly a unique, newly invented sound. Timbre is the subjective,
audible quality that distinguishes one instrument from another. Most
synths are multitimbral, that is, they can produce several different
instrument sounds at once. This way you can have an entire band
playing your composition.

Voices can usually be allocated dynamically. This means that when a
voice is no longer needed, it immediately becomes available for another
instrument. Occasionally, a MIDI arrangement calls for more voices
than the synth can provide. Voices are then “stolen” from older notes to
make the newer ones. For this reason, it’s always a good idea to assign
the more critical parts of an arrangement to lower-numbered MIDI
channels. Voices are stolen from the higher numbered channels first.

Wavetable Synthesizers

Recently the technology of wavetable synthesizers has come into
common use. These synthesizers use memory to store brief sound
samples made from recordings of actual instruments. To play a note,
the synthesizer looks up and retrieves the appropriate sample, manipu-
lates it as needed and plays the sound. This system is considered to
create more realistic instrument sounds, as opposed to the older FM
(Frequency Modulation) synthesis technique of creating synthesized
sound.
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Patches

Each instrument sound is commonly called a patch or program. The
terms are taken from the patch boards used to program early
synthesizers. The operator used wires, like those on an old telephone
switchboard, to “patch” or connect one electronic module to another.
The words “patch,” “instrument,” “program” or sometimes simply
“sound” are often used interchangeably.

Patches are usually identified by both a number and a recognizable
name like “Marimba” or “Harpsichord.” The numbers are always 0 to
127, though some systems label patches with numbers from 1 to 128
for clarity. A set of 128 patches is called a patch bank — or sometimes
a palette — and many synths allow you to change patch banks as
needed.

Notes

In MIDI, as in traditional music, a note is one of the most fundamental
units. It defines a pitch (for example, F#) and a duration (for example,
a half note). In MIDI, pitches are identified by numbers from 0 to 127.
On many keyboards, for example, Middle C is note number 72. The
duration is expressed in units of bars, beats and clicks. A click is the
smallest division of a note according to the current MIDI configuration
in a sequencer. As in traditional music, the duration of a note is
ultimately determined by the time signature and the tempo of the song.

MIDI note commands define other characteristics, too. These include
start time (which establishes where in the composition the note
occurs) and velocity (which corresponds to how hard a key is struck).

Non-Note Messages

Not all MIDI commands play notes; some control the overall
characteristics of the song or the behavior of the synthesizer. These
non-note events include commands that set the key signature and
tempo, change patches, and a host of other parameters.
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Each synthesizer will vary in its response to these messages, depending
on its design and features. If a synth fails to respond to certain message
types, it isn’t necessarily a malfunction. It may simply be that the synth
wasn’t designed to support that feature.

Channels

Each MIDI note must be assigned to one of 16 channels. The note will
then be played with the patch assigned to that channel. For example, if
a violin patch has been assigned channel 4, all notes played on that
channel will sound like violins. If you change the patch assignment for
channel 4 to oboe, the sound changes to oboe.

Tracks

Imagine an arrangement that includes three clarinets playing in
harmony. Since they all share the clarinet patch, they can share a
channel. To assign the same patch to three different channels would
waste the synth’s resources. As you edit the arrangement, you need
some way to keep the parts separate. In traditional music notation, you
might put each part on its own staff.

The MIDI equivalent is to place each part on its own track. Each track
must be assigned to a channel, and therefore a patch. The composer
has considerable freedom in the use of tracks. Several tracks can be
assigned to the same channel, and each track’s channel assignment can
be changed independently.

For example, suppose you decided to change one of the clarinet parts
to an oboe, without changing the other two. You could assign its track
to another channel — and assign an oboe patch to that channel.
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Melodic and Percussion Instruments
There are two broad categories of instruments: melodic instruments
and percussion (drum) instruments. Each melodic instrument requires
a full range of notes, such as all the keys on the MIDI keyboard, and
must have its own channel and patch assignment.

Percussion instruments, however, don’t rely on pitch. You cannot play
F-sharp on a cymbal or a snare drum the way you can on a piano or
clarinet. So, while you need the entire range of the MIDI keyboard to
play a melodic instrument like a piano, you only need a single key to
play a cymbal.

Drum Channel

Because each drum instrument requires only one key, all the drums are
gathered onto a single channel, and one key is assigned to trigger each.
Every synthesizer has a drum channel for this purpose. This channel
usually cannot be changed and is almost always channel 10 or 16.

If data created for a melodic instrument is inadvertently directed to the
drum channel — or vice-versa — the synth attempts to play it anyway.
The result is typically a strange collection of noises.

Ports

If there are only 16 channels — and each instrument claims one of
them — how would you manage an arrangement that requires more
than 16 instruments? This question leads us to the final parameter that
MIDI data needs to reach its destination — a MIDI port.

Each set of 16 channels is assigned to a port, and a MIDI system can
have several ports. Unlike channels and tracks, which are characteris-
tics associated with MIDI data, ports are more closely associated with
MIDI hardware. Ordinarily, each port is connected to a different MIDI
device.
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MIDI Hardware
To provide the ports necessary to control external MIDI devices, a
computer requires hardware called a MIDI interface. An interface is
typically a card installed in one of the bus slots on the computer’s
motherboard. It has one or more 5-pin DIN plugs to communicate with
external MIDI devices. A cable connects the interface to a plug on the
MIDI device. Each of these connections represents one MIDI port.

Each port is identified by a number and functions as an input or an
output. Two-way communication requires both types. The computer
receives data from a synthesizer (during recording) via an input port,
and sends data to the synthesizer (during playback), via an output port.
MIDI data travels only in one direction, so the MIDI Out plug from one
device is always connected to the MIDI In of another. Multiport inter-
faces permit a single computer to control several 16-channel MIDI
devices.

Many synths also have a specialized variant of the MIDI Out port, called
MIDI Thru. A MIDI Thru simply takes the data that arrives at the MIDI
In connector, echoes (repeats) it, and sends it out again, unchanged, via
the MIDI Thru connector. This provides a way to connect several
synthesizers together.

Sound Cards
Sound cards don’t require a MIDI interface or a cable; the connection to
the computer is established when the card is plugged into its slot. Since
you cannot “play” a sound card as you would a keyboard, sound cards
don’t have a MIDI output port. Instead, they have connectors that send
audio signals to devices such as headphones, speakers, or an amplifier.

However, many sound card designs allow for a simple kind of MIDI
interface, so your computer can communicate with external MIDI
devices in addition to the sound card. Usually it’s an optional adapter
cable that you plug into the sound card’s joystick connector.

Every synth, whether it’s internal (built into a sound card) or external
(connected by means of an interface) must be identified by a port
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number. Since a sound card doesn’t need an actual physical port, it’s
given a kind of artificial — or virtual — port assignment. The most
common arrangement is to call the sound card’s external MIDI
connector Port 1 and the synthesizer built into the sound card Port 2. If
your system had two external (real) ports, the virtual port for the sound
card would be port 3, and so on.

Windows 3.1 MIDI Mapper
When you install MIDI hardware such as a sound card or a MIDI inter-
face, an applet called the MIDI Mapper is added to your Windows 3.1
Control Panel.

Ordinarily, when you use a sequencer to play a MIDI file, you direct the
output — the MIDI data — to the driver for your synthesizer. The driver
manages the communication between the software application (the
sequencer) and the hardware (the synthesizer).

The MIDI Mapper offers another option: instead of directing MIDI data
to your synthesizer’s driver, you can send it to the MIDI Mapper. To the
Windows application, the MIDI Mapper appears to be a software driver.

The MIDI Mapper intercepts data from the software application and
passes it on to your synthesizer’s driver. What is the purpose of this
extra step?

Before sending data along to the synth’s driver, the MIDI Mapper can
translate or re-map it. Depending on how you configure the MIDI
Mapper, it can re-direct data (change its destination), it can halt data
(prevent it from reaching your synthesizer) or it can just pass the data
along unchanged. You can re-map channels, patch assignments and
even individual keys — all independently of each other. This re-
mapping function lets you reconcile differences between a MIDI file
and your MIDI hardware.

For example, suppose all your MIDI files have drums on channel 10, but
the drum channel on your synth is channel 16. You could use your
sequencing software to open, edit and save every one of your files
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individually — changing channel 10 to channel 16, dozens or possibly
hundreds of times.

A far less tedious solution would be to create a MIDI Mapper Setup that
always re-maps data from channel 10 to channel 16. This approach
offers two advantages:

• In one step you’ve made it possible for all the MIDI files to play
on your synthesizer.

• Because you didn’t alter the MIDI files, they will still play
correctly on other synths.

The same file, in fact, can play correctly on any synth that has its own
correctly configured setup. Because you can create and save as many
setups as you wish and switch among them as needed, you can play the
same file on a variety of synthesizers.

The Windows User’s Guide and the MIDI Mapper‘s help file explain
how to operate the MIDI Mapper. Consult these sources to set your
MIDI Mapper correctly for your configuration.

 All your setups are saved in a single file called
MIDIMAP.CFG in your WINDOWS\SYSTEM directory.

Always make a backup copy of MIDIMAP.CFG before
you change any MIDI hardware or software.
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Windows 95 MIDI Configuration Screen
Beginning with Windows 95, the MIDI Configuration dialog box
replaces the MIDI Mapper utility, but it has different capabilities.

You can open the MIDI Configuration screen by selecting Multimedia
from the Control Panel, then selecting the MIDI tab. In the MIDI Tab
window you select the Custom Configuration option button and then
click the Configure button. The MIDI Configuration dialog box opens.

Selecting a channel and clicking the Change button opens the Change
MIDI Instrument Dialog box where you can set the driver assignments
for the selected channel.

Digital Audio
Digital Audio differs from MIDI in that it records sound, not a sequence
of commands.

The hard drive is the storage medium; it serves the same function as
tape does in a conventional tape recorder, but with one major
difference: Sound, which occurs in nature as a series of waves, must be
converted to a series of numbers that your computer can read.

To do this, most PC-based digital audio hardware uses a technique
called Pulse Code Modulation, or PCM. (That’s why digital audio is
sometimes referred to as “PCM audio.”) Incoming electrical signals in
the form of waves (analog signals), such as those from a microphone,
are turned into numbers by a circuit called an Analog to Digital
Converter (ADC) and saved in computer memory. These numbers can
be saved in a file, and you can manipulate this data as easily as you
would text in a word processor.

When you play the file, a Digital to Analog Converter (DAC) converts
the numbers back into analog electrical signals. Audio equipment then
amplifies these signals and sends them to speakers or headphones,
where you hear them as sound.
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Data Formats

The digital audio files most commonly used by Windows are called
Wave files, identified by the .WAV file extension. Another type is the
.VOC file, originally developed by Creative Labs for their Sound
Blaster™ products, and widely supported by other manufacturers.
Among digital audio files there are various data formats available. Each
data format has four defining characteristics:

Sample Rate — To record sound, the ADC must select and measure a
sample (a discrete instant in the sound wave), and store its amplitude
(a measure of its loudness) as a number in your computer. To capture a
sustained interval of sound, this process must be repeated very rapidly.
The sample rate is the frequency with which the sampling process
occurs.

Sample rates are generally expressed in Kilohertz, or thousands of
cycles per second. A typical digital audio recording might be sampled at
11,025 Hz (samples per second), or 11.025 kHz. Generally, higher
sample rates produce better sound fidelity, but a high sample rate can
generate so much data that it can outpace the processor of your
computer or overrun the capacity of your hard disk.

Bit Length — The amplitude of each sample is expressed as a number
and, like all values stored in a computer, these are binary numbers. The
electronic “digits” that represent numbers are called bits. Bit resolution
(also called “bit length” or “sample size”) is the number of binary digits
that make up each sample. Eight bits can represent a range of values
from 0 to 255, while sixteen bits can represent values from 0 to 65,535.
Most digital audio programs, including Voyetra’s Digital Orchestrator
Plus,™ now use 16 bits as a standard.

With the larger bit lengths, digital audio data can be measured more
precisely. As an illustration, imagine two tape measures. Both are 10
feet long, but one is marked with 255 divisions, the other with 65,535.
Although both may be perfectly accurate, the latter is more precise.
The larger bit lengths provide better sound fidelity, but again, there’s a
price—your system must process more data.
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Compression — To speed processing of large amounts of data, many
sound cards use data compression to reduce the size of the data files.
Before the data is stored, some of it is removed and, on playback, this
data is artificially restored.

Because you cannot edit compressed data, AudioView does not support
this feature. However, if you export recorded data as a WAV file you
can use compression software on the resulting data. Your system—and
any others on which the file will be played—must have the necessary
hardware and software to work with the compression format you
select.

Mono or Stereo — Stereo digital audio consists of two sets of data
working together, one assigned to the left channel, the other to the
right. Thus, at a given sample rate and bit length, a stereo file requires
twice as much data as its mono equivalent. Again, you face the issues of
computer system speed and hard disk storage capacity whenever you
work with stereo files.
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Appendix B

General MIDI
Instrument Sets

General MIDI Patch Set
The General MIDI Patch Set was designed to ensure compatibility
between files by defining a common set of instrument names and MIDI
numbers. This means, for example, that if you set a track to Patch #4,
“Honky-tonk Piano,” it should sound pretty much the same when
played on any other General MIDI synthesizer or sound card.

These instrument sounds correspond to the numbers in the Instrument
row in MIDI Orchestrator.

For more information on setting patches, refer to the section on
“Assigning Instrument Sounds with the Instrument Selector” in the
chapter on MIDI Orchestrator.



212 AudioStation 2

PIANO
1 Acoustic Grand Piano
2 Bright Acoustic Piano
3 Electric Grand Piano
4 Honky-tonk Piano
5 Rhodes Piano
6 Chorused Piano
7 Harpsichord
8 Clavinet Chromatic

BASS
33 Acoustic Bass
34 Electric Bass (finger)
35 Electric Bass (pick)
36 Fretless Bass
37 Slap Bass 1
38 Slap Bass 2
39 Synth Bass 1
40 Synth Bass 2

REED
65 Soprano Sax
66 Alto Sax
67 Tenor Sax
68 Baritone Sax
69 Oboe
70 English Horn
71 Bassoon
72 Clarinet

PERCUSSION
9 Celesta
10 Glockenspiel
11 Music box
12 Vibraphone
13 Marimba
14 Xylophone
15 Tubular Bells
16 Dulcimer

STRINGS
41 Violin
42 Viola
43 Cello
44 Contrabass
45 Tremolo Strings
46 Pizzicato Strings
47 Orchestral Harp
48 Timpani

PIPE
73 Piccolo
74 Flute
75 Recorder
76 Pan Flute
77 Bottle Blow
78 Shakuhachi
79 Whistle
80 Ocarina

ORGAN
17 Hammond Organ
18 Percussive Organ
19 Rock Organ
20 Church Organ
21 Reed Organ
22 Accordion
23 Harmonica
24 Tango Accordion

ENSEMBLE
49 String Ensemble 1
50 String Ensemble 2
51 SynthStrings 1
52 SynthStrings 2
53 Choir Aahs
54 Voice Oohs
55 Synth voice
56 Orchestra Hit

SYNTH LEAD
81 Lead 1 (square)
82 Lead 2 (sawtooth)
83 Lead 3 (calliope lead)
84 Lead 4 (chiff lead)
85 Lead 5 (charang)
86 Lead 6 (voice)
87 Lead 7 (fifths)
88 Lead 8 (bass + lead)

GUITAR
25 Acoustic Guitar (nylon)
26 Acoustic Guitar (steel)
27 Electric Guitar (jazz)
28 Electric Guitar (clean)
29 Electric Guitar (muted)
30 Overdriven Guitar
31 Distortion Guitar
32 Guitar Harmonics

BRASS
57 Trumpet
58 Trombone
59 Tuba
60 Muted Trumpet
61 French Horn
62 Brass Section
63 Synth Brass 1
64 Synth Brass 2

SYNTH PAD
89 Pad 1 (new age)
90 Pad 2 (warm)
91 Pad 3 (polysynth)
92 Pad 4 (choir)
93 Pad 5 (bowed)
94 Pad 6 (metallic)
95 Pad 7 (halo)
96 Pad 8 (sweep)
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SYNTH EFFECTS
97 FX 1 (rain)
98 FX 2 (soundtrack)
99 FX 3 (crystal)
100 FX 4 (atmosphere)
101 FX 5 (brightness)
102 FX 6 (goblins)
103 FX 7 (echoes)
104 FX 8 (sci-fi)

PERCUSSIVE
113 Tinkle Bell
114 Agogo
115 Steel Drums
116 Woodblock
117 Taiko Drum
118 Melodic Tom
119 Synth Drum
120 Reverse Cymbal

ETHNIC
105 Sitar
106 Banjo
107 Shamisen
108 Koto
109 Kalimba
110 Bagpipe
111 Fiddle
112 Shanai

SOUND EFFECTS
121 Guitar Fret Noise
122 Breath Noise
123 Seashore
124 Bird Tweet
125 Telephone
126 Helicopter
127 Applause
128 Gunshot
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General MIDI Drum Note Map
Like the General MIDI Patch Set, the General MIDI Drum Note Map
ensures that the drums you designate in your MIDI file will sound the
same when played back on other General MIDI sound cards or
synthesizers.

The drum sounds correspond to the piano keys on the vertical
keyboard in the Piano Roll screen. If you have a General MIDI (GM)
instrument and set the track to Channel 10, these drum sounds will play
when you insert notes in the Piano Roll screen.

MIDI
#

KEY/
Octave

Drum
Sound

35 B2 Acoustic Bass Drum
36 C3 Bass Drum 1
37 C#3 Side Stick
38 D3 Acoustic Snare
39 D#3 Hand Clap
40 E3 Electric Snare
41 F3 Low Floor Tom
42 F#3 Closed Hi-Hat
43 G3 Hi Floor Tom
44 G#3 Pedal Hi-Hat
45 A3 Low Tom
46 A#3 Open Hi Hat
47 B3 Low-Mid Tom
48 C4 High-Mid Tom
49 C#4 Crash Cymbal 1
50 D4 High Tom
51 D#4 Ride Cymbal 1
52 E4 Chinese Cymbal
53 F4 Ride Bell
54 F#4 Tambourine
55 G4 Splash Cymbal
56 G#4 Cowbell
57 A4 Crash Cymbal 2
58 A#4 Vibraslap
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MIDI
#

KEY/
Octave

Drum
Sound

59 B4 Ride Cymbal 2
60 C5 High Bongo
61 C#5 Low Bongo
62 D5 Mute High Conga
63 D#5 Open High Conga
64 E5 Low Conga
65 F5 High Timbale
66 F#5 Low Timbale
67 G5 High Agogo
68 G#5 Low Agogo
69 A5 Cabasa
70 A#5 Maracas
71 B5 Short Whistle
72 C6 Long Whistle
73 C#6 Short Guiro
74 D6 Long Guiro
75 D#6 Claves
76 E6 High Wood Block
77 F6 Low Wood Block
78 F#6 Mute Cuica
79 G6 Open Cuica
80 G#6 Mute Triangle
81 A6 Open Triangle
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General MIDI Controller Types
General MIDI Controller Types are specified with numbers from 0-127
and control various instrument parameters such as pitch bend, effects
depth, and volume.

The chart below lists the controller types, their numbers, name and
possible values.

 # NAME POSSIBLE VALUES
1 MOD WHEEL 0 - 127
2 BREATH 0 - 127
4 FOOT PEDAL 0 - 127
5 PORTAMENTO TIME 0 - 127
6 DATA SLIDER 0 - 127
7 MAIN VOLUME 0 - 127
8 CONTINUOUS RELEASE 0 - 127
10 PAN 0 - 127
11 EXPRESSION CONTROL 0 - 127
64 SUSTAIN 0 = off/127 = on
65 PORTAMENTO SWITCH 0 = off /127 = on
66 SUSTENUTO SWITCH 0 = off /127 = on
67 SOFT SWITCH 0 = off /127 = on
68 2ND RELEASE SWITCH 0 = off /127 = on
84 PORTAMENTO 0 - 127
91 EFFECTS 1 DEPTH 0 - 127 (Normally Reverb)
92 EFFECTS 2 DEPTH 0 - 127
93 EFFECTS 3 DEPTH 0 - 127 (Normally Chorus)
94 EFFECTS 4 DEPTH 0 - 127
95 EFFECTS 3 DEPTH 0 - 127
96 DATA PLUS 0 = off/127 = on
97 DATA MINUS 0 = off/127 = on
121 RESET ALL CONTROLLERS normally 0
123 ALL NOTES OFF normally 0
124 OMNI MODE OFF normally 0
125 OMNI MODE ON normally 0
126 MONO MODE ON 0/all voices to mono
127 POLY MODE ON normally 0
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Appendix C

Shortcut Keys
The following keyboard shortcut keys correspond to the Transport
Control buttons on the Players.

Transport
Control

Keyboard
Shortcut

Action
It Performs

W Rewinds the file/track to the
beginning by increments, quickly.

S Stops playback of the file/track.

P Plays the file/track from the current
position.

A Pauses playback of the file/track at
the current cursor position. To
resume playing, press Pause again.

F Moves the cursor position forward,
quickly.
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R Activates Record Standby; prepares to
record MIDI files with MIDI Player.
Recording begins when the Play
button is pressed.

T Jumps back to the previous event in
the playlist.

N Jumps forward to the new event in
the playlist.

You can use the TAB key to highlight each
button from left to right. To activate the
highlighted button, press the Spacebar.
When the volume control is highlighted, use
the arrows keys to move the sliders up or
down.
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Appendix D

Setting Up Your MIDI
Keyboard

To fully utilize the features of MIDI Orchestrator and the MIDI Player,
you’ll need to have a MIDI keyboard properly connected to your PC.

A MIDI adapter cable attaches the keyboard to your PC. This cable uses
the joystick port on your sound card as a MIDI interface. One end of the
cable has a multipin connector which attaches to the sound card. The
other end of the cable has two connectors — MIDI In and MIDI Out —
which are connected to the MIDI keyboard.

If you need a MIDI adapter cable — or a MIDI
keyboard — you can purchase one at your local
computer store or you can order one directly from
Voyetra. See page ii at the front of this manual for
information on how to contact Voyetra
Technologies.
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Making the Connections

The following illustration describes how to connect a MIDI cable.

To view a video which demonstrates how to connect the
MIDI adapter cable, see “MIDI Cable Installation Video”
which follows.

OPTIONAL:
Connect this port
to your joystick.

Connect this 15-pin port
to your sound card.

MIDI OUT — Connect this
to the MIDI IN on your
MIDI keyboard.

MIDI IN — Connect
this to the MIDI OUT

on your MIDI
Keyboard.

NOTE: If you have a MIDI
keyboard controller —
instead of a MIDI synthesizer
— there may not be a MIDI In
connector, so leave this cable
unconnected.
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IN

OUT

IN OUT

Typical MIDI setup with a musical keyboard.

MIDI Cable Installation Video

MediaCheck, Voyetra’s multimedia diagnostic utility program which
automatically installs on your system when you install AudioStation 2,
includes a video which demonstrates how to connect a MIDI keyboard
to your PC.

In order to watch the video, the AudioStation CD
must be in your CD-ROM drive!
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To View the Video:

1. Put the AudioStation disc in the CD-ROM drive.

2. In the Voyetra program group, click the icon for MediaCheck.

3. In MediaCheck, click Setup Tips at the bottom left of the
screen.

4. When asked if you want to view instructions on setting up your
external keyboard, click Yes.

5. Sit back and watch the video!

Unlike the other AudioStation video tutorials
which can be accessed from the Online Video
Tutorials icon in the Voyetra AudioStation
program group, this video can only be accessed
directly from within MediaCheck!
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Appendix E

Troubleshooting
Fortunately, the situations that cause the most multimedia problems are
among the easiest to fix. Start your troubleshooting journey with the
general suggestions below. If you still have problems, look up the
specific symptoms you’re experiencing.

Throughout the troubleshooting process, don’t forget another valuable
resource — the hardware manuals that came with your sound card or
other peripherals.

First Things First...
First, confirm that your sound card is connected to a working output
device such as headphones, speakers or an amplifier with speakers. If
you are using speakers, make certain that they:

• Are plugged into the correct port on your sound card.

• Are turned on and have the volume set to an adequate level.

• Have their own source of power. Most sound cards can supply
enough power for headphones, but not for external speakers.
Depending on the type, your speakers will need to be plugged
into a wall outlet or an amplifier, or will be powered by
batteries.
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If you must use headphones when testing your
multimedia devices, we advise you not to place
them directly on your ears. The volumes produced
can cause hearing damage.

If the speakers are not the problem, then you will have to check your
multimedia devices. To do so, you can use:

• Windows® Media Player

• Voyetra’s MediaCheck™

Media Player
There are three devices you can test using the Windows Media Player:
the MIDI Sequencer, digital audio (Sound), and Video.

To Open the Media Player in Windows 3.1:

1. Double-click the Accessories program group.

2. Double-click the Media Player icon.

To Open the Media Player in Windows 95:

1. Click Start.

2. Point to Programs. Point to Accessories. Point to Multimedia.

3. Click Media Player. Media Player opens.

To Test Multimedia Devices with Media Player:

1. Click Device to display the multimedia devices on your system.
If you do not see Sound, Video for Windows or MIDI Sequencer
listed in the menu, they are not properly installed on your
system. Refer to your user’s manual or contact your hardware
manufacturer for assistance.

2. Click the name of the device — Sound, Video for Windows, or
MIDI Sequencer — you want to test.
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3. Locate a file of the type of media you want to test and click
Open.

4. Click the Play button. If you hear the sound or MIDI or see the
video, the drivers are installed and working properly. If any of
these multimedia devices fail to operate correctly, contact your
hardware manufacturer.

Setting the Mixer
Some of the basic problems that occur with multimedia applications
can easily be remedied by checking the Windows 95 mixer. With the
mixer, you can control the volume of the different components on your
computer’s sound system.

Windows 3.1 does not include a mixer, although many sound cards
include mixer applications for Windows 3.1. If you are running
Windows 3.1, check your sound card’s documentation to determine if
you have a mixer and how to access it.

In Windows 95, the Audio Mixer included with AudioStation does
emulate the Windows Sound System, and it can be use to set volumes
on the different multimedia components. However, we suggest that
you use the Windows Sound System volume controls when testing each
device’s volumes. This ensures that everything is working properly. If
the Windows Sound System does not work correctly, neither will the
Audio Mixer.

To Open the Windows 95 Mixer:

1. Click Start.

2. Point to Programs. Point to Accessories. Point to Multimedia.

3. Click Volume Control. Make any necessary changes from the
Volume Control Panel.
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Troubleshooting the Mixer

❝ The sound is too low or I don’t hear any sounds at all. ❞

❝ Some of my components work, but others do not. For
example, I can hear MIDI but I cannot hear WAV (digital
audio).❞

Possible Problem

The mixer settings are too low or some of the components are muted.

Possible Solution

Check the mixer to make sure all of the components’ volumes are at
least half way to the top. Also, check that none of the components are
muted. In particular, check the Master volume setting if there is one.

❝ MIDI and WAV (digital audio) files do not play simulta-
neously. ❞

Possible Problem

The sound card cannot support the simultaneous playing of MIDI and
WAV.

Possible Solution

Open two instances of Media Player. In one play a MIDI file, in the
other play a WAV file. If they do not play simultaneously, contact your
sound card manufacturer.

❝ I don’t see all the components when I run AudioStation.❞

Possible Problem

The component is not activated.

Possible Solution

On AudioStation’s Power Bar, click the icon for the component to
activate it. When a component is active, the light on its icon is lit.
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Troubleshooting MIDI

❝ I can’t find the connectors to hook my sound card and my
MIDI keyboard together. ❞

Possible Problem

Your keyboard is not a MIDI device. Not all synthesizers or electronic
keyboards support MIDI.

Possible Solution

Look for round MIDI plugs labeled MIDI IN, MIDI OUT or MIDI THRU.
They are usually found on the back panel of the MIDI keyboard. If your
keyboard is not equipped with these plugs, you will not be able to hook
your keyboard to your computer.

Possible Problem

Your sound card did not come with a MIDI connector cable.

Possible Solution

Most sound cards don’t have MIDI connectors. A special adapter cable
that connects to the joystick port is used instead. The manufacturer of
your sound card can probably provide you with one, or you can
purchase one from Voyetra.

❝ I’m getting sound, but there’s interference with it. ❞

Possible Problem

A hum, hissing or other constant undertone of noise usually indicates
electrical interference or a hardware malfunction.

Possible Solution

Increase the sound card’s output level and lower the amplifier’s
volume. If that doesn’t help, try it the other way around.

If you are not able to resolve this problem, contact the hardware
manufacturer.
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❝ Music files that work with other Windows programs or
tracks from my CD player won’t load into MIDI
Orchestrator.❞

Possible Problem

You tried to open a file that isn’t supported by MIDI Orchestrator.

Possible Solution

Be sure the file is a valid MIDI file with a .MID, or .ORC extension.
Digitally recorded sound files — those with WAV, VOC extensions, or
CD Audio Tracks — can’t be used by a MIDI sequencer.

❝ I cannot record from my MIDI keyboard. ❞

❝ I do not hear anything when I play my MIDI keyboard. ❞

Possible Problem

Your sound card isn’t connected to an output.

Possible Solution

Be sure your sound card is connected to a working output device such
as headphones, speakers or an amplifier with speakers — and that you
are using self-powered speakers. The sound card’s amp isn’t designed
to power external speakers.

Possible Problem

Your MIDI cables are not plugged in correctly.

Possible Solution

Make sure that the MIDI cable runs from the MIDI keyboard’s MIDI Out
to the computer’s MIDI In and vice versa.

Possible Problem

Your synthesizer is not set up to transmit MIDI.
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Possible Solution

Some MIDI instruments send and/or receive MIDI data automatically, or
can be configured to do so. Others require that you take specific steps
to transmit MIDI each time you turn on the synthesizer. Check your
MIDI instrument’s instructions to find out how to set it up to transmit
MIDI. The salesperson who sold you the MIDI instrument may also be
helpful.

Possible Problem

Your synthesizer and computer are set to different MIDI ports and/or
channels.

Possible Solution

Make sure that MIDI Orchestrator’s MIDI Input, which can be set in the
Options menu, is set to the same input that your MIDI instrument is
connected to.

Possible Problem

The MIDI drivers are not properly configured.

Possible Solution

Run MediaCheck to diagnose and fix the problem.

Possible Problem

There is no power to the MIDI keyboard.

Possible Solution

Check to make sure the MIDI keyboard is plugged in and turned on.

❝ I can hear music when I play my MIDI keyboard, but I can’t
record. ❞

Possible Problem

You have not selected a track for recording.
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Possible Solution

Be sure that the Record button for a channel module is selected.

Possible Problem

Your synthesizer is sending on one channel and/or port and the
software is set to receive on another.

Possible Solution

Be sure you know which port and channel your synth is using to send
MIDI data and that the track you’ve selected for recording has the same
settings. MIDI Orchestrator sends MIDI data through the device
configured in the MIDI Mapper (in Windows 3.x) or the MIDI
Configuration Screen (Windows 95). Check these settings to make sure
the MIDI data is being properly routed.

❝ Some of the tracks on my MIDI Orchestrator are grayed out.
Why? ❞

Possible Problem

Your MIDI Mapper is not setup properly.

Possible Solution

MIDI Orchestrator is designed to play on 16 tracks. If a few are grayed
out, it is due to the set up of your MIDI Mapper. Most sound cards are
optimized for the MIDI Mapper configuration of Extended MIDI; that is,
they will play on tracks 1 through 10 only. This is to ensure you get the
best sound quality.

Run MediaCheck to determine the best setting for your sound card.

❝ When playing a MIDI file I don’t hear anything. ❞

Possible Problem

The MIDI file is an Extended Level file and your sound card is set up for
Base Level, or vice-versa.
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Possible Solution

Run MediaCheck to help diagnose and resolve the problem.

❝ When I change the patch on one track, some of the other
tracks change too. ❞

Possible problem

You have assigned several tracks to the same channel. (This isn’t really
a problem—the program is designed to work this way.)

Possible solution

Assign the track to a different channel. Patches are assigned to
channels, not to tracks, so when you change a patch, you change it for
every track assigned to that channel.

❝ When I play the MIDI keyboard, I hear a strange echo or the
notes sound doubled-up — thicker. Sometimes I run out of
voices and not all the notes sound. ❞

Possible problem

Your MIDI file contains a Base-Level and an Extended Level
arrangement, and you’re trying to play both of them at the same time.

Possible solution

Set the MIDI Mapper in Windows 3.1, or the MIDI Configuration in
Windows 95, to play only channels 1 through 10, or only channels 13
through 16. MediaCheck can help you determine which option is
correct for your situation.

Possible problem

The MIDI data arriving at the MIDI In is echoed to the MIDI Out.
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Possible solution

If you are using a keyboard controller, try turning the local control off.
See the documentation for the keyboard to do this.

❝ It sounds as if tracks are missing from my MIDI file. Also,
other parts sound very strange and there are no drum
sounds. ❞

Possible Problem

Your MIDI Mapper in Windows 3.1 or the MIDI Configuration in
Windows 95 is not set up properly; you’re trying to play an Extended-
Level arrangement on a Base-Level synth.

Possible Solution

In Windows 3.1, check that the MIDI Mapper is set up correctly for
your sound card.

In Windows 95, check that the MIDI configuration is set up correctly
for your sound card.

Possible Problem

The file could just be too complex for your synth.

Possible Solution

Edit the file so it doesn’t demand as many simultaneous notes and/or
instruments from your synth.
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Troubleshooting Video

❝ Videos do not play. ❞

Possible Problem

Video for Windows is not installed.

Possible Solution

Run SETUPFW.EXE from the VFW directory on the CD.

❝ I can see the video, but I do not hear any sound. ❞

Possible Problem

Your mixer is set too low.

Possible Solution

Check the mixer and increase the output volume setting for WAV.

❝ My video playback skips. ❞

❝ The sound and the video are not in sync. ❞

Possible Problem

Your system is too slow.

Possible Solution

Close any other applications which are open. Also, close any TSRs
(Terminate and Stay Resident programs) such as screen savers.

Use a 2x (double-speed) or faster CD-ROM.
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 Troubleshooting Digital Audio

The following items can help resolve the digital
audio problems you may be having with WAV
Player. If any of these problems occur and you
need to change the format or tune the perform-
ance of a WAV file, launch AudioView. AudioView
lets you make changes to the performance and
formatting of a WAV file.

❝ I cannot hear any digital audio. ❞

Possible Problem

You do not have the correct drivers installed.

Possible Solution

Check to make sure you have the latest drivers for your sound card. Use
MediaCheck to determine the dates of the drivers installed.

Run Media Player and test the device labeled Sound. If Sound does not
work, contact your sound card manufacturer.

❝ The sound sometimes stutters and/or stops. ❞

Possible Problem

Your system may be too slow. The demands of recording and editing
digital audio can tax many computer components, particularly older,
slower ones.

Possible Solution

Close any open applications.

Check to make sure you have the latest drivers for your sound card.
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❝ The sound is garbled. ❞

Possible Problem

If sound suddenly stops or “stutters,” and/or locks up your computer,
you probably have a hardware conflict—more than one device trying to
use the same IRQ, I/O address or DMA channel.

 Possible Solution

Check your user’s manual or contact your hardware manufacturer for
help on how to resolve these type of problems.

❝ I have received one of the following error messages —
“Unsupported Audio File Format,” “ Invalid Bit Length,”
“Invalid Sample Rate.” ❞

Possible Problem

If you try to play a file whose format (sample rate, bit length,
mono/stereo setting, etc.) is not supported by your sound card,
AudioView will display one of the above error messages. This is more
likely to occur with files created on a different system.

Possible Solutions

You may need to re-create or convert the file. Check the hardware
documentation to determine the digital audio capabilities of your sound
card and use a format that it supports.

❝ My file starts to play and then quits. ❞

❝ Sound seems to cut in-and-out or sounds broken up. ❞

❝ I received the message “Disk could not keep up with digital
audio.” ❞
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Possible Problem

These symptoms usually stem from the speed requirements of digital
audio. A 16 bit, 44 kHz file, for example, moves almost 100K of data per
second through the computer system, pushing computers, hard drives
and CD drives to their limits.

Possible Solutions

Close any Windows applications that you are not using.

Reduce the screen display’s demands.

Disable the Record VU or Playback VU, and select No Wave from the
Options menu in AudioView.

Decrease the sample rate.

If you are attempting to record 16-bit audio, try switching to 8-bit.

If you’re recording in stereo, try switching to mono.

Troubleshooting CD Audio

❝ My CD won’t play.❞

Possible Problem

The material loaded may not be compatible with an audio CD.

Possible Solution

Because CDs can store different kinds of material, the phrases “Playing
an audio track” and “Playing a game” describe different kinds of
activity:

To play Redbook Audio tracks , that is, recordings on CDs that you
would buy in a record store—use CD Player.

To play games —in other words, to run software programs designed for
recreation or education, don’t use the CD Player application. Consult
the instructions that came with the game CD to find out how to install
and/or run the game or program.
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Voyetra End-User License
Agreement

By installing this Software you acknowledge that you have read, understood and agree
to abide by the terms and conditions of this Agreement. If you do not agree with the
terms of this Agreement, promptly contact the seller of this Software to arrange an
appropriate remedy.

SOFTWARE LICENSE: This is a legal agreement (Agreement) between you (either
an individual or an entity) and Voyetra Technologies (Voyetra) that sets forth the license
terms and conditions for using the enclosed software (Software) and updates of the
Software. In this Agreement, the term “Use” means loading the Software into RAM, as
well as installing it onto a hard disk or other storage device.

The Software is owned by Voyetra and is protected under United States copyright
laws as well as international treaty provisions. You must treat the Software as you would
any other copyrighted material. Voyetra retains title and ownership of the Software. The
purchase price for the Software grants you a non-exclusive license to use one copy of
the Software on a single computer. You may make copies of the Software solely for
archival purposes. You may not make copies of any written material accompanying the
Software. You may not allow third parties to use the Software by time-sharing,
networking or any other form of multi-user participation. You may not rent, sell, lease,
sub-license, time-share or lend the Software to a third party or otherwise transfer this
License without written permission from Voyetra. You may not decompile, disassemble,
reverse-engineer or modify the Software.

This Agreement is effective until terminated by the destruction of the Software — all
of the CD-ROMs and/or diskettes — and documentation provided in this package,
together with all copies, tangible or intangible. If you fail to comply with any of the
terms and conditions of this Agreement, this License will be terminated and you will be
required to immediately return to Voyetra the Software — CD-ROMs and/or diskettes
— and documentation provided in this package, together with all back-up copies. The
provisions of this Agreement which protect the proprietary rights of Voyetra will
continue in force after termination.

LIMITED LIABILITY: You assume responsibility for the selection of the Software
to achieve your intended results, and for the installation, use and results obtained from
the Software.
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VOYETRA MAKES NO REPRESENTATIONS OR WARRANTIES WITH
REGARD TO THE SOFTWARE AND DOCUMENTATION, INCLUDING BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.

Voyetra shall not be liable for errors or omissions contained in the Software or manuals,
any interruption of service, loss of business or anticipatory profits and/or for incidental
or consequential damages in connection with the furnishing, performance or use of
these materials. The Software and documentation are sold AS IS.

This Limited Warranty gives you specific legal rights and you may also have other rights which
vary from state to state. Some states do not allow the limitation or exclusion of implied warranties
or of consequential damages, so the above limitations or exclusions may not apply to you. You
agree that this is the complete and exclusive statement of the Agreement between you and Voyetra
which supersedes any proposal or prior agreement, oral or written, and any other communications
between us regarding the subject matter of this Agreement. This Agreement shall be construed,
interpreted and governed by the laws of the State of New York, except the federal laws which
govern copyrights and registered trademarks. If any provision of this Agreement is found
unenforceable, it will not affect the validity of the balance of this Agreement, which shall remain
valid and enforceable according to its terms.
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Index

1

16 - 8 bits · 114, 176

A

About box · 82
Acknowledgments · 4
Advanced button

Audio Mixer · 40
Advanced controls

Audio Mixer · 42
Ambience · 160
Ambience · 161
Amplitude · 209

AudioView · 107, 108
Amplitude vs. Volume

AudioView · 108
Analog to Digital Converter (ADC) ·

208
Audio Capabilities & Related Data ·

194, 195
Audio CD

playing · 66
Audio Mixer · 15, 37

Advanced button · 40
Advanced controls · 42
Configure dialog box · 47
configuring · 47
controls, adding · 48
controls, changing order · 49, 50

controls, removing · 49
customizing · 43
icons, changing · 43
launching · 26, 33
Mute buttons · 40, 41
playback controls · 40
playback mode · 39
Record controls · 41
record mode · 39
sound sources · 38
switching between two mixers ·

46
AudioStation

Audio Mixer · 37
AudioView · 101
CD Player · 65
controls · 27
installing · 19, 20
launching · 23, 36
launching applications · 21
launching Players · 26
MIDI Orchestrator · 71
MIDI Player · 67
online video tutorials · 22
playlists · 51
Power Bar · 33
program group · 21
rack · 21, 23, 24
running the software · 21
sample files · 17
Uninstalling · 21
using the manual · 3
WAV Player · 95

AudioView · 15, 101
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16 - 8 bits · 176
16 -> 8 bits Transform · 114
amplitude · 107, 108
Amplitude vs. Volume · 108
auditioning files · 127
Auto Audition · 117
Auto Rewind · 117
Background color · 119, 122
Bit Length · 110
Change Speed · 177
Change Speed Transform · 114
Channels · 124
Clipboard · 119, 120, 121
     checking contents · 137
     loading a file from · 146
     pasting contents of · 138
     saving a file from · 147
Copy · 112
Crossfade Transform · 114, 174
Current Position indicator · 110
Cut · 112
Data Format · 124
DC Offset · 173
DC Offset Transform · 114
Delete · 112
Delete button · 141
deleting a section of a file · 141
digital audio data compression ·

125
disabling options · 118
Echo Transform · 114, 159, 161,

162
Echoes, creating your own · 163
Edit buttons · 105
edit function, using · 135
Edit menu · 112
EDIT.WAV file · 135
enabling options · 118
End time · 130
Erase · 112
Erase button · 142
Fade Transform · 114, 167

File Format · 124
File Info · 119, 124
File Length · 110
File menu · 111
File Size · 124
file
     changing speed · 177
     cutting a section · 136
Find Peak Transform · 114, 165
Global transforms · 175
Graphic File Display · 106
Halve Sample Rate · 176
Halve Sample Rate Transform ·

114
Help menu · 127
Insert Silence · 112
Invert Samples Transform · 114,

172
launching · 99, 102
Load File Into Clipboard · 112
magnified view of waveform ·

134
Mix Paste · 112, 139
No Wave · 117
Noise Gate Transform · 114, 170
Normalize Transform · 114, 155
OLE · 178
opening files · 128
Options Menu · 117
Overview · 117
Overview Bar · 109
Paste · 112
Pasting · 138
Peak color · 119, 122
Play Buffer · 122
Play Position Marker · 107
Play Position Marker, setting ·

129
playback problems · 118
Playback VU · 117
playback,
     choosing a starting point · 129
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     pausing · 128
Playing files · 127, 128
Pre-Write · 123
Range Controls · 104
Range, selecting · 130
     selecting with mouse · 131
Record Buffer · 123
recording problems · 118
recording
     adjusting signal level · 149
     preparing your system for ·

148
reduced view of waveform · 134
Reverse Transform · 114, 154
Ruler · 107, 117
Sample Rate · 110, 124
Samples · 124
Save Clipboard · 112
saving files · 152
Scale Transform · 114, 157
screen · 102
Scroll bar · 107
Select All · 112
Setup · 119
Setup dialog box · 119
silence, inserting · 145
Start Point Indicator · 138
Start time · 130
Status Box · 110
Stereo - Mono transform · 114,

176
Stereo/Mono · 110
time · 107
Transforms · 153
Transforms buttons · 105
Transforms Menu · 114
Transport control · 103
Trim · 112
Trim button · 143
Tune Performance · 119, 122
tutorial, editing · 135
Undo · 105, 112, 141

Undo button · 144
View Entire · 117
VU Meters · 104, 150

WAV -> VOC · 176
WAV -> VOC Transform · 114
Wave color · 119, 122
Windows menu · 119
Zoom buttons · 106, 133
Zoom In · 117
Zoom Out · 117

Audition · 63
Audition button · 63
Auditioning

digital audio files · 127
Auto Audition

AudioView · 117
Auto Audition button · 63
Auto Rewind

AudioView · 117

B

Background color
AudioView · 119, 122

Base Level · 200
Bit Length · 209

C

CD audio · 38
testing · 194

CD Player · 15, 65
audio CD, playing · 66
CD tracks, naming · 57
Intro Play · 63
Intro Play indicator · 66
keyboard shorcut keys · 217
launching · 26, 33
MultiCD indicator · 66
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Pause indicator · 66
play indicator · 66
playlist modes · 66
playlist,
     creating · 55, 57
     listening to · 60
screen areas · 66
transport controls · 27, 28, 29

Change Field transform · 177
Change Speed

AudioView · 114
Change Speed transform · 177
Channel Info · 85
Channel Info dialog box

Instrument · 88
MIDI Orchestrator · 87
Naming or Renaming a Track · 88
Selected Track · 88
Tracks · 87
Transpose · 88
Transposing a Track · 89

Channel Module Controls
MIDI Orchestrator · 84

Channels · 203
AudioView · 124

Clipboard
AudioView · 119, 120, 121
     checking contents · 137
     loading a file from · 146
     pasting contents of · 138
     saving a file from · 147

Clock Rate · 81
Close · 34
Close button · 32
Close MIDI IN While Using Wave ·

80
Configure dialog box

Audio Mixer · 47
Contents · 82
Controller Events · 198
Controller Types

General MIDI · 216

Copy,
     AudioView · 112
Crossfade

AudioView · 114
Crossfade transform · 174
Current Bar · 74
Current Song Position · 73
Current Tempo · 73
Current Time · 74
Cut, AudioView · 112

D

Data compression  · 210
digital audio · 125

Data format  · 209
AudioView · 120, 124

DC Offset · 173
AudioView · 114

Delete
AudioView · 112

Delete button
AudioView · 141

Depth · 160
Digital audio

configuring · 191
editing files · 100
Files · 209
Overview · 208
testing input · 190

Digital audio (WAV) · 38
Digital audio data compression ·

125
Digital audio files

background noise, reducing · 171
deleteing a section of · 141
file, changing speed · 177
modifying with transforms · 153
playing · 97
recording · 98
saving · 152
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silence, inserting · 145
trimming · 143
troubleshooting · 234

Digital to Analog Converter (DAC) ·
208

Drum channel · 204
Drum tracks · 17
Duration · 202

AudioView · 121

E

Echo
AudioView · 114

Echo transform · 159, 162
Edit buttons

AudioView · 105
Edit function

using in AudioView · 135
Edit menu

AudioView · 112
EDIT.WAV file · 135
Eject · 28, 29
Erase

AudioView · 112
Erase button

AudioView · 142
Extended Level · 200

F

Fade
AudioView · 114

Fade transform · 167
dialog box · 168
Fade In · 168
Fade Out · 168
Fast Exponential · 169
Linear · 169
True Exponential · 169

Fast forward · 28, 29
File, cutting a section
     AudioView · 136
File Format

.VOC File · 209

.WAV File · 209
AudioView · 120, 124

File formats
MID · 93
ORC · 93
RMI · 93

File Info
AudioView · 119, 124

File Menu
AudioView · 111
MIDI Orchestrator · 77

File Size
AudioView · 124
playing digital audio · 128

Files
opening digital audio · 128
playing, choosing a starting point

· 129
Find Peak

AudioView · 114
Find Peak transform · 165
Format, AudioView · 121
From

AudioView · 121

G

General MIDI · 200
Controller Types · 216
Drum Note Map · 214
Patch Set · 211

General MIDI Patch Set · 211
Global transforms

AudioView · 175
Graphic File Display

AudioView · 106
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H

Halve Sample Rate · 176
AudioView · 114

Hardware
headphones · 18
requirements · 17, 18
speakers · 18

Help button · 32
Help Menu

AudioView · 127
MIDI Orchestrator · 82

I

Icons
changing, Audio Mixer · 43

Insert Silence
AudioView · 112, 145

Installing the software · 19
Instrument Selector · 85

assigning instruments with · 85
Instruments · 201
Internet · 2, 14
Intro Play · 63, 68

setting amount of time · 64
using · 64

Intro Play button · 52
Intro Play indicator
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